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Abstract
Seldén Mast is a world leading producer of aluminium sail boat masts. The company has
also been developing and producing carbon fibre masts and poles for sail boat rigs for
the last 20 years. Carbon fibre composites are high-performing and expensive materials,
and any improvements made to the layup of the laminates will create a lighter and less
expensive product. Seldén’s composite masts are produced with a method called filament
winding, where the resin impregnated fibre tows are wound onto a rotating aluminium
mandrel with the same shape as the inside of the finished mast.

The goals of the project have been to accurately predict the bending stiffness and de-
flection behaviour of any given mast or pole produced by this method, to evaluate the
compressive stiffness and strength of Seldén’s laminates. As well as characterising the
micro structure of the carbon fibre laminate in terms of out-of-plane waviness and relat-
ing this to the compressive strength of the laminate. A mix of FE analyses using the
FEA software LUSAS together with actual benchmark testing has been used to compare
simulation to reality. The use of high resolution misalignment analysis (HRMA) has
been implemented to characterise the out-of-plane-waviness of the laminates. A method
to experimentally determine the compressive strength of a carbon fibre tube has been
developed and tested.

Comparing the test results to the results from the FE computations shows that it is
possible to come within 15% of the actual deflection when using Seldén’s previously
obtained material data. There are however signs of asymmetrical bending and stiffness
behaviour in non-circular cross-sections. This may occur as a result of the handling of
the masts during production, but also due to irregularities in the production technique
itself. Strength assessments based on the HRMA were shown to be in good agreement
with the experimental values. The method developed in this project to experimentally
determine compressive strength of a carbon fibre laminate tube has been shown to give
satisfactory results. However, to completely confirm the method, the failure mode of the
laminates in the test has to be identified.

Keywords: filament winding, stiffness modelling, carbon fibre, strength in compression,
HRMA
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1 Introduction
According to The Seldén Group, they are the world leading manufacturer of sailboat
rigging systems and deck hardware for dinghies, keel boats and sailing yachts. Seldén
produces and sells both aluminium and carbon fibre composite masts.
Seldén has been producing carbon fibre composite mast sections since year 2000. Ac-
cording to the company, good production technique, composite skills and experience has
given them good products that are very competitive. However, improvements can always
be made to optimise stiffness, strength and weight and also material and production costs
of the laminates.
Filament winding is the manufacturing process currently employed by Seldén to produce
composite masts. This method allows for parts of the process to be automated with less
variations in the layup, compared to composite masts produced with hand laid laminates.
In this project the effects of the filament winding process on the finished product, have
been studied and documented.

1.1 Background

Carbon fibre composites (Carbon Fibre Reinforced Polymer - CFRP) are high perfor-
mance construction materials. With a high specific stiffness and strength compared to
other materials such as aluminium, carbon fibres can be used to make a structure lighter,
stiffer and stronger at the same time. These properties come at a high price since carbon
fibres are expensive and energy demanding to produce. The use of composite laminates
in high-end applications is also usually more labour intensive as compared to more tra-
ditional materials. Any optimisation regarding material usage or production cycle time
will make a big difference for the end user. Seldén’s composite products have previously
been designed using quick and easy calculations together with the expertise of their en-
gineers. Their designs have been proven over time, but there is a chance that they can
be improved further. Better predictive capabilities of stiffness based on numerical sim-
ulations and a better understanding of compressive strength will help Seldén to achieve
these improvements.
The process of filament winding has been researched extensively in previous works, mainly
relating to the winding process itself and different ways of calculating the roving trajec-
tories along the geometry of the product being manufactured. However research focused
on the material properties that come as a result of the production process is scarce, and
no papers on the subject were found during the initial phase of the current master thesis.

1.2 Purpose and aim

The main purpose of the current master thesis was to find consistent methods and rou-
tines to model and optimise the mast section laminate layups further. The laminate
calculations have been carried out with the FEA software LUSAS, regularly used by

1



1 Introduction

Seldén in their design work.
The main task of the thesis was to find a consistent method to model the laminate layup
(produced by the filament winding method) in LUSAS. Focus has been on the stiffness
and weight properties of the laminates. Model predictions were also benchmarked against
practical bending tests. The proposed method was also to be converted into a short
guideline for future use within the company.
To further increase the understanding of compressive failure in the carbon fibre mast,
the out of plane waviness of the fibre was practically measured in laminates produced
by Seldén. Waviness characteristics may then be used as input for models to more
precisely predict the compressive strength. These studies were compared with practical
compression tests performed during the project.

1.3 Limitations

A number of limitations were applied to the project from the start in order to focus the
work better. The limitations are listed below.

• The modelling methods developed in this project will be specifically adapted to lam-
inates produced with filament winding. No studies will be performed on laminates
produced with other manufacturing methods.

• As requested by Seldén, FE-simulations will be performed exclusively with the FEA-
software LUSAS, unless it is found to be insufficient for the needs of the project.
This is due to the fact that LUSAS is the main FEA-software used at Seldén.

• Variations in the material system of the test specimen, i.e. the type of fibre or
matrix, will not be evaluated. The production method and product quality is
also fixed. Any optimisation suggestions will only be with regards to layup. One
exception is in the case of low modulus fibre implementation where a separate kind
of fibre will be used in the calculations.

• Compressive failure is the only failure mode that will be evaluated in this project.
This is the dominant failure mode, together with buckling, that Seldén has identified
as potential problems in their composite masts.

• Material data provided by Seldén will be used as far as possible.
• Many of the components that make up a complete mast (such as spreaders, boom

brackets, mast step, head box etc.) will not be treated in this project since these
components will have negligible or no effect on the stiffness of the mast. Hence
only the bare mast without any additional components, sometimes referred to as
the "tube", will be treated in this work. Neither will the full rigging (the mast
together with sails, standing rigging, spreaders, boom, running rigging etc.) be
discussed in any depth in this work. Both Larsson, Eliasson, and Orych (2014) and
Bethwaite (2008) provide useful information on the subject of rigging types, rigging
dynamics and rig design.

2



2 Theory

2.1 The mast

The mast is a main component of any sailing yacht, sailing dinghy or sailing boat, both
present and historically. On a sailing vessel the mast can be considered as a cantilever
beam, since during rigging it is common practice that pre-bend is introduced through
shrouds, backstay and forestay. At the same time, due to the compressive loading in-
troduced by the rigging the mast is also acting as a column. In both of these load
configurations, acting at the same time, the stiffness of the mast is a main design pa-
rameter. To be able to control and predict the pre-bend during rigging and to prevent
buckling during operation it is important to have an accurate prediction of the mast stiff-
ness. Considering the equation of elastic behaviour of a pinned-end column in Equation
(2.1) as well as the basic equation of bending of a beam in Equation (2.2) (Ugural & Fen-
ster, 2011), both equations show that the bending stiffness EI, defined as the product of
Young’s modulus E times the cross-section area moment of inertia I, will have influence
on both the buckling load P and deflection w of a beam subjected to bending. It is clear
that bending stiffness is paramount when defining the characteristics of the mast.

EI
∂2w

∂x2 + Pxw = 0 (2.1)

∂2

∂x2

(
EI

∂2w

∂x2

)
= qz (2.2)

In Figure 2.1 the outline of a typical mast section is presented. Key locations and their
names are marked with arrows. The arrows mark the locations of the fore-line, aft-line
and B-lines. These lines run vertically along the length of the mast. The fore-line marks
the foremost position on the section, likewise the aft-line marks the aftmost position on
the section. The B-lines mark the widest part of the section. These terms are internally
accepted at Seldén and will be used throughout this project.
Figure 2.1 also defines the orientation of axes where x runs from port to starboard while
y runs from aft to fore. While z runs along the length of the mast. This orientation
is to be employed throughout this entire project. Bending from aft to fore, i.e bending
stiffness around the x-axis, will be denoted EIx. Bending stiffness around the y-axis, EIy
will be related to the bending from port to starboard.

3



2 Theory

Figure 2.1: Outline of a typical mast section

2.2 Composite laminates

The material from which the masts in this project is made of is a composite laminate.
Composite in the sense that two (or more) constituent materials are mixed to form a new
material, with the mixed properties of its constituents. Laminate in the sense that several
thin layers, also known as plies, of composite material are stacked in sequence to form a
laminate with the combined properties of all its plies. In short, several plies stacked in
sequence make up a laminate. The plies are in turn made up of several constituents, that
make up each ply.

In this specific case, the composite is a carbon fibre reinforced plastic (CFRP). Contin-
uous, unidirectional carbon fibres are embedded in a matrix. The matrix, also known
as the resin being a thermosetting polymer bonds the fibres together. In Figure 2.2
the schematics of a single CFRP ply is shown. The Cartesian coordinate system 123 is
oriented so that the 1-axis is parallel to the unidirectional fibres of the ply.

The plies are stacked in sequence to form the composite laminate shown in Figure 2.3.
By orienting the plies, desired properties of the lamina can be achieved.

4



2 Theory

Figure 2.2: Fibre reinforced composite ply

Figure 2.3: Composite laminate

2.2.1 Material properties

The fibre composite falls under the category of specially orthotropic materials. Unlike
isotropic materials that exhibits symmetry of the elastic properties in all three planes,
the orthotropic material is symmetric with respect to two planes. In the case of fibre
composites the symmetry exists around two orthogonal planes, so that the elastic prop-
erties does not change when the axis perpendicular to the planes are reversed (Agarwal,
Broutman, & Chandrashekhara, 2017).
In addition to this, the fibre composite is often considered to be a transversely isotropic
material. Meaning that the 23 plane is a plane of isotropy. The transversely isotropic
material has five independent elastic constants. In Equation (2.3) the stiffness matrix of

5
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a specially orthotropic, transversely isotropic material can be seen (Agarwal et al., 2017).





σ1

σ2

σ3

τ23

τ13

τ12





=




C11 C12 C12 0 0 0
C12 C22 C23 0 0 0
C12 C23 C22 0 0 0
0 0 0 C22−C23

2 0 0
0 0 0 0 C66 0
0 0 0 0 0 C66








ε1

ε2

ε3

γ23

γ13

γ12





(2.3)

If the laminate is in plane stress conditions the out of plane stress components are zero

σ3 = τ23 = τ13 = 0 (2.4)

Thus, the stiffness matrix in the stress-strain relation of Equation (2.3) can be simplified
to





σ1

σ2

τ12





=




Q11 Q12 0
Q12 Q22 0
0 0 Q66








ε1

ε2

γ12





(2.5)

where the new stiffness coefficients are defined in Equations (2.6).

Q11 = C11 −
C2

13
C33

Q22 = C22 −
C2

23
C33

(2.6)

Q12 = C12 −
C13C23

C33

Q66 = C66

Since the combined material properties of a laminate will be dependent on the orientation
of the plies of which the laminate is made up from, it is necessary to refer the stress and
strain of the plies to a common coordinate system. The transformation of stresses from
the local coordinate system 123 of the ply into the global coordinate system XY Z can
be seen in Equation (2.7) (Agarwal et al., 2017).





σx

σy

τxy





=
[
T1
]−1





σ1

σ2

τ12





(2.7)

T1
−1 is the inverse of the stress transformation matrix T1 seen in Equation (2.8), where

θ is the orientation of the ply in relation to the global coordinate system XYZ.
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[T1] =




cos2 θ sin2 θ 2 sin θ cos θ
sin2 θ cos2 θ −2 sin θ cos θ

− sin θ cos θ sin θ cos θ cos2 θ − sin2 θ


 (2.8)

Likewise, with the strain transformation matrix T2 in Equation (2.9), the strains can be
transformed from 123 to XY Z according to Equation (2.10).

[T2] =




cos2 θ sin2 θ sin θ cos θ
sin2 θ cos2 θ − sin θ cos θ

−2 sin θ cos θ 2 sin θ cos θ cos2 θ − sin2 θ


 (2.9)





εx

εy

γxy





=
[
T2
]−1





ε1

ε2

γ12





(2.10)

Substituting Equation (2.7) and (2.10) into (2.5) gives Equation (2.11).





σx

σy

τxy





= [T1]−1




Q11 Q12 0
Q12 Q22 0
0 0 Q66


 [T2]





εx

εy

γxy





(2.11)

Thus, the elastic properties of the ply can be related to the global coordinate system.
For the sake of simplicity Equation (2.11) is usually expressed as Equation (2.12) where
Q̄ is given by Equation (2.13).





σx

σy

τxy





= [Q̄]





εx

εy

γxy





(2.12)

[Q̄] = [T1]−1[Q][T2] (2.13)

2.2.2 Analysis of the orthotropic laminate

The state of strain in a composite laminate can be described in terms of mid-plane strain
and plate curvature of the laminate. The relation between total strain, mid-plane strain
and plate curvature is given by Equation 2.14 (Agarwal et al., 2017).





εx

εy

γxy





=





ε0
x

ε0
y

γ0
xy





+ z





kx

ky

kxy





(2.14)

Where z is the coordinate through the thickness of the laminate. It can be seen that
the strain will vary linearly through the thickness of the laminate. This is due to the
assumption that plies does not slip in relation to each other (Agarwal et al., 2017). By
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substituting Equation (2.14) into Equation (2.12) the state of stress in the i:th ply of a
laminate is given by Equation (2.15).





σx

σy

τxy




i

= [Q̄]i





ε0
x

ε0
y

γ0
xy





+ z[Q̄]i





kx

ky

kxy





(2.15)

It is clear that stress in the ply will be dependent on the direction θ of the ply stiffness
matrix Q̄i. Stress will vary linearly within the thickness of each ply. However, across the
laminate thickness, and across adjacent plies, the stress gradient will be discontinuous
due to the differing directional properties of the plies.
With the stresses in the ply, the forces and moments acting on the cross-section of the i:th
ply can be obtained by integrating over the thickness of the ply according to (Agarwal
et al., 2017).





Nx

Ny

Nxy




i

=
∫ hi

hi−1





σx

σy

τxy




i

dz (2.16)





Mx

My

Mxy




i

=
∫ hi

hi−1





σx

σy

τxy




i

zdz (2.17)

The total forces and moments acting on the cross-section of the entire laminate are
obtained by summing the contribution from all n plies.





Nx

Ny

Nxy





=
n∑

i=1





Nx

Ny

Nxy




i

=
n∑

i=1

∫ hi

hi−1





σx

σy

τxy




i

dz (2.18)





Mx

My

Mxy





=
n∑

i=1





Mx

My

Mxy




i

=
n∑

i=1

∫ hi

hi−1





σx

σy

τxy




i

zdz (2.19)

By substituting Equation (2.15) into (2.18) and (2.19), the relation between forces and
moments acting on the laminate, and the mid-plane strain and plate curvature of the
laminate is obtained.





Nx

Ny

Nxy





=
n∑

i=1

∫ hi

hi−1


[Q̄]i





ε0
x

ε0
y

γ0
xy





+ z[Q̄]i





kx

ky

kxy






 dz (2.20)





Mx

My

Mxy





=
n∑

i=1

∫ hi

hi−1


[Q̄]i





ε0
x

ε0
y

γ0
xy





+ z[Q̄]i





kx

ky

kxy






 zdz (2.21)
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From Equation (2.20) and (2.21) three new matrices A, B and D can be defined as
Equations (2.22) to (2.24)

[A] =
n∑

i=1

∫ hi

hi−1
[Q̄]idz =

n∑

i=1
[Q̄]i(hi − hi−1) (2.22)

[B] =
n∑

i=1

∫ hi

hi−1
[Q̄]izdz = 1

2

n∑

i=1
[Q̄]i(h2

i − h2
i−1) (2.23)

[D] =
n∑

i=1

∫ hi

hi−1
[Q̄]iz2dz = 1

3

n∑

i=1
[Q̄]i(h3

i − h3
i−1) (2.24)

The constitutive equations (Equations (2.20) and (2.21)) of the laminate are simplified
and condensed in to Equation (2.25).





Nx

Ny

Nxy

Mx

My

Mxy





=




A11 A12 A16 B11 B12 B16

A12 A22 A26 B12 B22 B26

A16 A26 A66 B16 B26 B66

B11 B12 B16 D11 D12 D16

B12 B22 B26 D12 D22 D26

B16 B26 B66 D16 D26 D66








ε0
x

ε0
y

γ0
xy

kx

ky

kxy





(2.25)

Forces are related to the mid-plane strains through the extensional stiffness matrix A.
Moments are on the other hand related to plate curvature through the bending stiffness
matrix D. The coupling stiffness matrix B defines the coupling between forces and plate
curvature as well as the coupling between moments and mid-plane strains. For a non-
zero coupling matrix, this implies that normal and shear forces, in addition to mid-plane
strains, will cause the laminate to twist and bend. While moments will cause mid-plane
strains in addition to bending and twisting. (Agarwal et al., 2017)

2.2.3 Application to beam theory

To be able to apply the the classical laminate theory presented in the previous section
on a laminated cantilever beam, a number of assumptions and simplifications have to
be made (Hajianmaleki & Qatu, 2011) (Agarwal et al., 2017). These assumptions and
simplifications may not be applicable on the masts analysed in this project, at least not
with satisfactory results. Still, the derivation presented here may provide insight on how
the stiffness coefficients in Equation (2.25) relates to the stiffness of a mast.
Consider a laminated cantilever beam of length L and width b, loaded so that the resultant
forces and moments are according to Equations (2.26) and (2.27).

Ny = Nxy = 0 (2.26)

My = Mxy = 0 (2.27)
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In addition to the above assumption, if Poisson’s effect, shear deformations and twisting
curvature of the beam mid surface are neglected so that they are 0, Equation (2.25) can
be reduced to Equation (2.29) (Hajianmaleki & Qatu, 2011).

ε0
y = γ0

xy = ky = kxy = 0 (2.28)

{
Nx

Mx

}
=
[
A11 B11

B11 D11

]{
ε0
x

kx

}
(2.29)

It is assumed that the beam is long and slender L >> b, so that the stresses and displace-
ments can be considered constant across the width of the beam (Agarwal et al., 2017).
Thus, the width b can be included in Equation (2.29).

{
Nxb

Mxb

}
=
[
bA11 bB11

bB11 bD11

]{
ε0
x

kx

}
(2.30)

The equations of motion gives the external forces per unit length acting on the beam in
the x and z directions, qx and qz respectively.

−qx = ∂

∂x
(Nxb)

−qz = ∂2

∂x2 (Mxb)
(2.31)

Inserting Equation (2.31) into (2.30) yields

−qx = ∂

∂x
(Nxb) = ∂

∂x

(
bA11ε

0 + bB11kx
)

−qz = ∂2

∂x2 (Mxb) = ∂2

∂x2

(
bB11ε

0 + bD11kx
) (2.32)

Mid plane strain and curvature of the beam middle surface are given by

ε0
x = ∂u0

∂x

kx = −∂
2w

∂x2

(2.33)

Where u is the extension along x and w is the deflection of the beam. Substituting
Equation (2.33) into Equation (2.32) gives that

−qx = ∂

∂x
(Nxb) = ∂

∂x

(
bA11

∂u0

∂x
− bB11

∂2w

∂x2

)

−qz = ∂2

∂x2 (Mxb) = ∂2

∂x2

(
bB11

∂u0

∂x
− bD11

∂2w

∂x2

) (2.34)
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Equation (2.34) gives two differential equations with the two unknowns extension and
deflection of the beam, u and w respectively. The differential equations can be written
as

bA11
∂2u0

∂x2 − bB11
∂3w

∂x3 = −qx

bB11
∂3u0

∂x3 − bD11
∂4w

∂x4 = −qz
(2.35)

Different loading and boundary conditions can be applied in Equation (2.35) when finding
the solutions for u and w, in this case the coupling between bending and extension will
be included.
If it instead is assumed that the laminate of the beam is such that the coupling stiffness
matrix is zero B = 0, i.e a symmetrical laminate. And no axial load of the beam is
present, qx = 0. Equation (2.34) can be simplified to

∂2

∂x2

(
bD11

∂2w

∂x2

)
= qz (2.36)

The similarity with Equation (2.2) is obvious. The bending stiffness of the laminated
beam is governed by bD11 much like the bending stiffness of an ordinary beam is governed
by EI. If this reasoning is applied to a pinned-end column, the equation of elastic
behaviour will become (Agarwal et al., 2017)

bD11
∂2w

∂x2 + Pxw = 0 (2.37)

The assumptions made to arrive at Equations (2.36) and (2.37) renders the application
of these equations to be restricted, making it necessary to perform the analysis of mast
stiffness through the use of FE-software in this project.

2.2.4 Calculation of hybrid laminate properties

Seldén has incorporated a method of mixing different types of fibres in some of their
products, creating what is referred to in this report as a hybrid laminate. This laminate
will have a new set of properties based on the individual properties of the different fibres.
The hybrid laminate evaluated is a combination of glass and carbon fibres. The material
properties for each separate material are known through previous material testing per-
formed by Seldén. However, no testing has been performed on the hybrid material. The
hybrid material properties therefore need to be calculated. Equation 2.38 was used for
this purpose. An initial calculation to get a reference value produced the values shown in
Table 2.1, where the hybrid Young’s modulus was simply calculated as the mean of the
carbon and glass composites’ Yong’s modulus.
A more detailed calculation of the Young’s modulus can also be done based on the filament
properties of the different tows. Data found online for the carbon fibre and glass fibre
tows respectively give the information shown in Table 2.2.

11



2 Theory

Table 2.1: Hybrid laminate constituents properties

Young’s modulus [GPa] Volume fraction1

T700 Carbon composite - -%
E-glass composite 43 -%
Hybrid composite -

Table 2.2: Properties of the different tows of the hybrid laminate

T700 Carbon fibre tow
(T700SC-12K-60E)

E-glass fibre tow
(158B-AB-450)

Number of filaments 12000 2000
Filament diameter [µm] 7 16.4
Resin content (RC) 0.32 0.25

By measuring the tow cross-section area, it is possible to calculate the actual ratio be-
tween the tow composites. The total tow area of each composite can be calculated using
Equation (2.38) assuming the area fraction Af is equal to the volume fraction Vf = 1−RC.

Atow = Afilament × nfilament
1−RC (2.38)

The actual ratio between carbon and glass fibres is then found to be the ratios stated in
Table 2.3 together with the actual theoretical Young’s modulus.

Table 2.3: Hybrid laminate

Young’s modulus [GPa] Actual volume fraction1

T700 Carbon composite - -%
E-glass composite 43 -%
Hybrid composite -

It is seen that the difference between the simplified Young’s modulus and the theoretically
correct one is small. The Young’s modulus shown in Table 2.3 is the one that has been
used in the hybrid laminate FE-simulations covered in Section 5.1.3.

2.3 Filament winding

The chosen production method for the composite masts at Seldén Mast is that of filament
winding. Traditionally, filament winding is used for rotationally symmetric objects and is
commonly used in the production of pressure vessels and tubes. The object is produced by
winding fibres and resin onto a rotating mandrel. The fibres can either be pre-impregnated
with resin (pre-preg) or led through a resin bath before being wound onto the mandrel.
The fibres are deployed to the mandrel via a carrier running back and forth along the
length of the mandrel. An image showing the resulting wind pattern as well as the
fibre application is shown in Figure 2.4. The fibre angle and placement is controlled by
varying the speed with which the carrier traverses the mandrel. The process is most often

1Sensitive information has been censored in the published version of this thesis.
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numerically controlled which allows for a highly controllable process and a final result of
consistent quality (Agarwal et al., 2017).

Figure 2.4: A carbon fibre mast during production. Photograph courtesy of Seldén Mast
Ltd.

2.3.1 Filament winding at Seldén

An exception to the process described above is when the product is not rotationally
symmetric, as in the case of most larger sail boat masts. A normal mast cross-section
has more of an oval shape such as the one previously shown in Figure 2.1, which leads to
some deviations in the final result compared to circular cross-sections.
The deviations in fibre angle can be derived from the fact that the winding machine at
Seldén treats the mast as a tube with a circular cross-section, and a fixed nominal radius,
while the actual mast will have a varying radius from the centre of rotation to the surface
of the fibres. An example of this is shown in Figure 2.5. It is not entirely clear how the
nominal radius is chosen in production, but it is assumed to be equal to or larger than
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the maximum distance from the centre of the mandrel.

Figure 2.5: Illustration of the varying radius of a mast section.
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When studying existing literature about filament winding, little is written about the
winding of non-circular geometries. The effects of the geometry on the fibre misalignment
is therefore largely unknown.

2.4 Effect of fibre out of plane waviness on compres-
sive strength

In Fleck (1991) it is stated that fibre kinking, also referred to as micro buckling even
though it has been proved not to be caused by instability, is the dominant compressive
failure mechanism of a fibre composite. The fibre kinking is initiated by an initial out
of plane misalignment of the fibre (Shu & Fleck, 1997). The kinking failure mechanism
is governed by the ability of the matrix to support the fibres under compressive loading.
Thus the shear limit τ of the resin, together with the magnitude of the initial fibre
misalignment angle will be the governing parameters of fibre kinking. A failure criteria
for fibre kinking was formulated by Argon as a ratio between the shear yield limit τ and
the initial fibre misalignment angle θ Argon (1972).

Xc = τ

θ
(2.39)
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It was shown by Wilhelmsson, Gutkin, Edgren, and Asp (2018) that it is possible to
measure the fibre misalignment θ through image analysis of micrographs of the fibre
composite.
The measured maximum misalignment angle can then be used as input in Equation
(2.39) to predict the compressive strength of the composite. In the work of Wilhelmsson
et al. (2018) a method of characterising the fibre out of plane waviness was developed.
The method was applied to non crimp fabric (NCF) composites. The definition of NCF
composites is covered in the work of Lomov (2011). In this project, the same method will
be applied to characterise the out of plane waviness of the filament wound composite.

2.5 Effect of fibre out of plane waviness on stiffness

Wilhelmsson, Asp, Gutkin, and Edgren (n.d.) found a correlation between reduced stiff-
ness and the magnitude of fibre out of plane waviness during compressive loading. This
reduction was formulated as a knock down factor η.

η =
(

1− Eexp
EROM

)
× 100 (2.40)

In Equation (2.40) the experimentally measured stiffness Eexp is compared to the stiffness
predicted by the rule of mixtures (ROM) EROM (Agarwal et al., 2017). Wilhelmsson et
al. (n.d.) approximated the stiffness reduction to approximately 7% per degree for the
mean misalignment angle.
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3 Material specifications
A critical part of any FE analysis is accurate material data in order for the model being
evaluated to give results that are as close to reality as possible.

3.1 Carbon Fibre Laminate Properties

The composite material properties of the carbon fibre laminate are given by Seldén and are
presented in Table 3.1. The material data was supplied from the Seldén office in England,
Seldén Mast Ltd., usually referred to as SML. It is still unclear how the material data
was obtained. Note that the value for G23 is missing. The corresponding value shown in
Table 3.22 has been used for both datasets in calculations and simulations.

Table 3.1: T700SC/UF3325 TCR Composite material properties

[GPa] [-] [t/mm3]
E1 - ν12 - ρ -
E2 - ν13 -
E3 - ν23 -
G12 - Vf -
G13 -
G23 -

This data can be compared to the calculated data based on the suppliers’ data sheets,
shown in Table 3.2.

Table 3.2: T700SC/UF3325 TCR Composite material properties, calculated using
Suppliers’ data.

[GPa] [-] [t/mm3]
E1 157 ν12 0.164 ρ 1.61E-9
E2 19 ν13 0.164
E3 19 ν23 0.40
G12 3.33 Vf 0.68
G13 3.33
G23 6.78

2Sensitive information has been censored in the published version of this thesis
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4 Methods
The methods used in the project vary between the different research fields. It is composed
of a combination of computer modelling and practical tests. The following sections will
give a detailed description of the computer modelling and test methods used.

4.1 Modelling stiffness of circular cross-sections

The stiffness modelling of circular cross-sections is performed by the use of FE-simulations,
where the development of the FE-modelling method is developed using benchmark tests
as references, most of which are made on two types of spinnaker poles. The method is
then tested on a third tube produced with a hybrid laminate of glass and carbon fibres, in
order to see if the method is applicable also in that case by the use of modified material
properties.

4.1.1 Benchmarking bend tests of spinnaker poles

In this work, the tests have been performed using equipment available at Seldén. The
size of the test specimens make it difficult or impossible to use conventional test rigs
for three-point bend tests. Therefore, it was decided that a non-conventional testing
method is to be applied. The schematics of the test can be seen in Figure 4.1. The same
test setup is used for both pole 39 and pole 88. The pole is simply supported with a
concentrated force F located at the middle of the span. During the tests the deflection
is measured at 5 locations (AL, BL, C, BR and AR) along the pole while the force F
is gradually increased. The deflection is calculated by measuring the distance between
the deflected pole and a laser beam positioned above the pole. It should be noted that
points AL, AR and BL, BR are placed with equal distances from the midpoint C. This is
done to verify the test results since theoretically, two points with equal distance from the
mid-point should have identical deflection in three-point bending. The simply supported
configuration is achieved by letting the pole rest in two slings attached to an overhead
crane. By anchoring the midpoint of the pole to a forklift, load can be applied by moving
the overhead crane in the vertical direction. The two slings are raised in a synchronised
manner, thereby avoiding excessive tilting of the pole. A spring and a scale is connected
between the forklift and the pole. The scale is used to measure the force applied by lifting
the blocks, and thus also the slings, of the overhead crane. The deflection relative the
laser beam can be measured with a ruler.
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Figure 4.1: Schematic sketch of test setup

Figure 4.2 gives an overview of the test setup and the measuring procedure. The pro-
cedure is: as the blocks of the overhead crane are moved a distance ∆z in the vertical
direction, the scale reading is noted. This gives the force F , which the pole is loaded
with at the mid-span. To get the deflection w of the pole under this load, the distances
between the supports and the laser beam (zLS and zRS) are measured. By measuring
these values, the distance z0 between the laser beam and undeformed pole can be calcu-
lated by drawing a straight line between the two supports, marking the position of the
undeformed pole, shown as a dashed line in Figure 4.2. Once the distance zlaser between
the deformed pole and the laser beam is measured, the deflection of the pole is simply
calculated using Equation (4.1).

w = zlaser − z0 (4.1)

Three point bending tests are performed on two different spinnaker poles, hereafter re-
ferred to as pole 39 and pole 88. Both spinnaker poles are produced by Seldén using the
filament winding method. The principal dimension of the poles are presented in Table
4.1.

Table 4.1: Principal dimensions of the spinnaker poles

Length [mm] Outer diameter [mm] Wall thickness [mm]
Pole 39 2600 39 1.5
Pole 88 4700 88 2.4

Both poles are filament wound with the T700SC fibre pre-preg to a fibre volume fraction
of Vf = 0.68 with the UF3325 TCR resin, both produced by TORAY. The poles employ
the layups presented in Table 4.2.
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Figure 4.2: Test setup and measuring procedure.

Table 4.2: Spinnaker pole layups

Layup3

pole 39 [−◦ −◦ −◦ −◦ −◦]
pole 88 [−◦ −◦ −◦ −◦ −◦ −◦]

4.1.2 Benchmarking bend test of hybrid laminate tube

As part of an internal quality control at Seldén bend tests had already been performed
on the hybrid laminate tubes. It should be noted that these tests were not performed
by the authors. However, the results were made available for the purpose of this project.
The test consisted of letting the tube rest on two trestles, one at each end of the tube.
A force is applied mid span of the simply supported mast. A principal sketch of the test
setup is shown in Figure 4.3.

The overall length LOA, the length of the span between the supports Lspan and the force
F located at the mid-span are presented in Table 4.3.

Table 4.3: Variables of the hybrid tube test.

LOA [mm] Lspan [mm] F [N]
3583 3540 245.5

In total, 53 identical hybrid laminate tubes were tested in this fashion. The deflection
under the load specified above were measured at 1/4, 1/2 and at 3/4 of the free span. The
average deflection and the standard deviation of all measured deflections are presented
in Table 4.4 below.

The average deflection w, is calculated using Equation (4.2) and the standard deviation
σw according to Equation (4.3).

3Sensitive information has been censored in the published version of this thesis.
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Figure 4.3: Test setup of hybrid laminate tube.

Table 4.4: Results of Seldén hybrid laminate tube tests.

Lspan/4 Lspan/2 3Lspan/4
w [mm] 26.3 38.5 26.3
σw [mm] 0.47 0.55 0.45

w = 1
n

n∑

i=1
wi (4.2)

σw =

√√√√
∑ (wi − w)2

(n− 1) (4.3)

The results in Table 4.4 are to be compared to a FE-model simulating the three-point
bend test described in this section.
The hybrid tube, as the name suggests is made from a hybrid laminate. A hybrid laminate
is defined in this project as a laminate composed of at least three material components,
as opposed to the usual two. The evaluated hybrid laminate is composed of glass and
carbon fibres together with a common matrix. Like the spinnaker poles the hybrid tube
has a constant circular cross-section. The principal dimensions of the tube is presented
in Table 4.5.

Table 4.5: Principal dimensions of the hybrid laminate tube

Length [mm] Outer diameter [mm] Wall thickness [mm]
3583 50 2.5

The hybrid laminate of the tube is arranged in the layup presented in Table 4.6.
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Table 4.6: The layup of the hybrid laminate tube.

Hybrid laminate tube layup4

[−◦ −◦ −◦ −◦ −◦ −◦ −◦ −◦ −◦]

4.1.3 Fibre angle measurement

An important property of any fibre reinforced laminate is the in-plane fibre orientation
(angle). Every laminate is designed with a nominal fibre angle to optimise performance.
This applies to Seldén’s composite products as well. The actual fibre angle of a com-
posite part may however differ from the nominal angle due to unintentional variations in
production, which will affect the performance of the part.

One part of this project is to evaluate if there is a difference between nominal and actual
fibre angle, and how large the difference is. If there is a difference, a fibre angle sensitivity
check will be performed in LUSAS to see how large the loss in performance is.

The actual fibre angle of the circular tubes was measured by tracing tape along one of
the fibre tows visible on the outside of the tube. A translucent sheet of plastic was then
wrapped around the tube, showing the tape underneath. It was also made sure that the
bottom edge of the sheet was perpendicular to the longitudinal axis of the tube when it
was wrapped around the circumference. A line was then drawn on the paper, following
the edge of the tape. The result is a diagonal line with the same angle relative to the
bottom of the paper as the fibres have to the longitudinal axis of the tube.

A large set of coordinates were then measured along the diagonal coordinates, using
the bottom of the sheet as the x-axis and the side edge as the y-axis. The measured
coordinates were then used as input in Matlab for further analysis of the angle variation.

4.1.4 FE model

The FE-models are made entirely in the FE-software LUSAS provided by Finite Element
Analysis Ltd. The poles are modelled as a surface making up a cylinder with constant
circular cross-section. The surface is then meshed with an 8-noded thick shell element,
QTS8 (LUSAS, 2017). The size of the elements is decided by conducting a convergence
study on the smallest pole, where the element size is decreased incrementally. The result
of the convergence study is shown in Figure 4.4. Based on the results, the element size
was set to 15× 15 mm in all models. Since the convergence study was performed on the
smallest pole, it was decided that the element size was suitable for and would be used
in all simulations for the sake of simplicity, even if it meant that the simulations would
take slightly longer time to run. An illustration of the finnished FE-model can be seen
on page 5 in Appendix B.

The supports are modelled as simple supports in a single point at the locations of the
supports in the tests. The load is applied as a distributed force, on the top half of the
cylinder on a single line located mid-span between the two supports. The type of supports
was chosen since it best represented the actual setup used in the benchmarking tests.

4Sensitive information has been censored in the published version of this thesis.
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Figure 4.4: Convergence study of mesh element size.

To take any geometrical non-linearity into consideration the Total Lagrangian formulation
is applied. A complete step by step guide describing how the modelling is performed can
be found in Appendix B. This guide was written in conjunction to this project on request
by Seldén.

4.1.5 Method for comparing model and tests

After the deflection has been measured in the test, linear regression is used to find the
correlation between the applied load F and the deflection of the pole w. The midpoint
deflection is of certain interest. Therefore, linear regression is performed on the test
results, as well as the results of the LUSAS model covered in Section 4.1.4. The correlation
coefficient is calculated using Equation (4.4).

ρ(wmid, F ) = 1
N − 1

N∑

i=1

(
wmid,i − µwmid

σwmid

)(
Fi − µF
σF

)
(4.4)

N is the number of data points, µ denotes a mean value and σ denotes a standard devi-
ation. With the correlation coefficient ρ the inclination k of the straight line describing
the relationship between load and mid-point deflection is found as Equation (4.5).

k = ρ
(
σwmid

σF

)
(4.5)

The mid-point deflection can now be approximated for any applied load, within reasonable
limits, as the expression in Equation (4.6).
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wmid,est = kF (4.6)

4.2 Modelling of non-circular cross-sections

The modelling of non-circular cross-sections follows the same procedure as for the circular
cross-sections in general, with some specific problems arising from the irregular shape of
the cross-sections. The masts are modelled in LUSAS and the results from the FE-models
are compared to practical tests.

The irregular shape in combination with Seldén’s choice of winding method will lead to
variations in the manufactured mast, which in turn will affect the stiffness properties of
the mast so that they differ from the intended properties. Major variations that have
been observed in this project are:

• Variations in fibre angle. Since the mast has a non-circular cross-section the fibre
angle of the laminate will vary around the circumference of the mast. In Section
4.2.2 it is explained how attempts to measure these variations are performed.

• Over consolidation of corners. Around sharp corners of the mast the thickness
of the laminate is drastically decreased, as shown in Figure 4.5. This will have a
geometric effect on the area moment of inertia of the section as well as the material
properties of the laminate. Since no fibres have disappeared and the laminate is
clearly thinner, it is reasoned that the volume fraction of the matrix is reduced.

Figure 4.5: Over consolidation.

• Fibre waviness. Since the tows of fibres are overlapped in a diamond shaped pattern
during the winding process, out of plane waviness of the fibres will occur. This is
illustrated in Figure 4.6 where the waviness of a fibre comes as a result of the
weaving.

All of the above mentioned variations will affect the stiffness properties of the mast.
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Figure 4.6: Fibre waviness.

4.2.1 Benchmarking bend tests of masts

As part of the validation of the FE results, three different masts, all of which are in
production and used on dinghies and larger sail boats, have been tested in bending.
These tests have been performed at Seldén’s carbon fibre mast production facilities in
England. They have all been tested and modelled including reinforcements along the
length of the masts. The principal dimensions of these masts are summarised in Table
4.7. LOA denotes the overall length of the mast, LPA is the parallel length of the mast,
i.e the length where the cross-section is constant. Ltop gives the length of the tapered
section. The cross-section of the tapered part of the mast, tapers off from the nominal
into the smallest cross-section at the very top of the mast. These variables and a rough
sketch of a mast are shown in Figure 4.7.

Figure 4.7: Sketch of a mast.

Table 4.7: Principal dimensions of modelled masts

LOA [mm] LPA [mm] Ltop [mm] tnom [mm] m [kg]
Sea Racer 35 16338 13973 2365 3.0 43.8

Farr 58 14662 11807 2855 6.6 124.0
J70 8910 6875 2035 2.4 11.7

The nominal wall thickness of the cross-section is given by tnom. The variable m denotes
the mass of the entire mast. The layups of the masts above are presented in Table 4.8.

The layups in Table 4.8 are the nominal layups. The Sea Racer 35 and J70 has UD
tape reinforcements in the mast. The UD tapes are located at the B-lines, fore-line and
aft-line of the mast. The UD tapes are added into the layup at these locations during the
winding process. A summary of the reinforcements for each mast can be found in Table
4.9.

The masts were tested in three-point bending, with the masts resting on wooden trestles
to achieve sharp and accurate support points. The tapered ends of the masts were put
outside the supports in order to only test the deflection of the regular cross-section. The
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Table 4.8: Nominal layups of the masts

Nominal layup5

Sea Racer 35 [−◦ −◦ −◦ −◦]
Farr 58 [−◦ −◦ −◦ −◦]
J70 [−◦ −◦ −◦ −◦]

Table 4.9: UD tape reinforced layups

Sea Racer 355

Port & starboard [−◦ −◦ −◦ −◦ −◦ −◦]
Fore & aft [−◦ −◦ −◦ −◦ −◦]

Width of UD tapes − mm
J705

Port & starboard [−◦ −◦ −◦ −◦ −◦ −◦]
Width of UD tapes − mm

load was incrementally applied mid-span, and the deflection was measured using a laser
as a reference.
Each mast was tested in bending in three directions, with the mast laying on its port,
starboard or aft side. The only exception is the Farr 58 mast which was not tested with
the aft side resting on the supports. This was due to the geometry of the cross-section.
After the bend tests were performed, the weight and centre of gravity of the masts were
also obtained.

4.2.2 Fibre angle measurement

The fibre angles of the non-circular masts are measured using the same method as for
the circular tubes - by tracing fibre tows with tape and transferring the line to a paper.
The difference is that the non-circular sections have an irregular fibre angle distribution
along its circumference due to the production method.
Since both the mandrel and the fibre tow cart are rotating and traversing with a constant
speed, the fibre angle will vary in every point of the circumference, depending on the local
radius from the rotational axis.

4.2.3 FE model

The masts are modelled in the same manner as for the spinnaker poles in Section 4.1.4. It
is assumed that the modelling method applied on circular cross-sections can be adapted
and applied also to non-circular cross-sections. The procedure follows the steps described
in Appendix B.

4.2.4 Comparison of model and tests

The masts are modelled in LUSAS according to the test setup, using the same type of
supports and loading. The obtained deflections are then compared to the test results in

5Sensitive information has been censored in the published version of this thesis.
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order to see how close the analyses gets to the tests, where the result of the comparison
is a percentage showing the difference.

4.3 Analysing fibre out of plane waviness

The second part of this thesis treats the laminate strength properties in compression.
The idea is that the compressive strength can be predicted using a recently developed
methodology for assessment of CFRP aeroengine components loaded in compression
(Wilhelmsson et al., 2018).
The first part of this subject is to fibre waviness of an authentic Seldén laminate using
a Matlab script developed at Chalmers which analyses digital pictures obtained from
microscopy of the laminate.
The method is based on characterising the fibre waviness in a section plane parallel to the
mode of failure, which in this case is out-of-plane. Thus, focus has been on characterising
the out-of-plane fibre waviness.

4.3.1 The samples

Samples of the laminate was cut from a spinnaker pole. The pole in question is the same
pole 39 mentioned in Section 4.1.1. A portion of the circumference of the spinnaker pole
section was cut out. In Figure 4.8 the cuts are symbolised by the dashed lines marked
A and B. It was made sure that the cut at A, was made perpendicular to the tangent
of the circle. The two arrows in Figure 4.8 marks the surface that will be examined
in the microscope. No measures were taken to make sure that the cut at line B was
perpendicular to the tangent. Therefore, no analysis is performed on this surface.

Figure 4.8: Schematics of test specimen cutting.

In total 6 specimens were manufactured. The samples were then cast in a clear epoxy
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resin. The surface that was to be examined under the microscope was gradually ground
and polished using semi-automatic grinding and polishing equipment from Struers. This
was done until a satisfying surface finish had been achieved.

4.3.2 Image processing of micrographs

Through a microscope, micrographs off the laminate were taken with 100 times magnifi-
cation. Several images are taken so that the entire specimen is covered. The images are
then joined to form a single panorama of each specimen. A cropped area of one of the
micrographs is shown in Figure 4.9 where each individual fibre is easily observed.

Figure 4.9: Part of a micrograph showing the cut fibres of the specimen.

An existing method has been used for measuring fibre misalignment in fibre waviness
through image processing of micrographs (Wilhelmsson & Asp, 2018). The method is
referred to as high resolution misalignment analysis (HRMA). This function is used to
measure the fibre out of plane waviness.
The micrograph panorama is read into the HRMA script. The script divides the micro-
graph into regions called cells. The size of these cells determine the spatial resolution.
In this analysis the cell size of 50 × 50 µm was applied. With the pixel resolution of
0.55 µm/pixel, the cell size becomes 91 pixels. The thickness of each ply in the sample is
approximately 300 µm, or 545 pixels, with the given pixel resolution. Thus, the resulting
spatial resolution is approximately 6 cells through the thickness of each ply. The global
fibre mean misalignment angle, across the entire micrograph panorama is then calculated
according to (Wilhelmsson & Asp, 2018)

θ̄ = 1
n

n∑

i=1
|θ̄i| (4.7)

Where |θ̄i| is the absolute value of the fibre mean misalignment in the i:th cell, and n is
the total number of cells measured.
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4.4 Compression strength analysis

Once the laminate stiffness knockdown factor mentioned in the previous section has been
obtained, several compression tests are performed to find the compressive stiffness and
strength of the same part.

4.4.1 Test specimens design

Previous compression tests of composite tubes have shown that the failure tends to initiate
on the edge of the tube, closest to the load cell. Crushing of the ends will not give a
representative result.
An alternative method of testing is proposed, where the point of failure initiation is
controlled by a local decrease in cross-sectional area of the tube. This decrease in area
is achieved by milling two slots parallel to the rotational axis of the tube, as shown in
Figure 4.10.

Figure 4.10: Dimensions and position of the slots.

The theory behind the design of the specimen is that the slots will force the failure to
initiate at the thinnest point of the test sections. An important design criteria for the
test specimen has been to minimise any bending of the test sections in order to obtain
a unidirectional stress state. The magnitude of the bending is calculated in Equation
(4.8) according to (ASTM D3410/D3410M-16, 2016). The same standard states that the
bending of the test specimen has to be less than 10% at failure strain for the strength
and strain–to–failure data to be considered valid.

Bending = ε1 − ε2

ε1 + ε2
× 100 (4.8)

In Equation (4.8), ε1 and ε2 is the strain at the inner and outer surface of the laminate.
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The design has been tested and analysed in LUSAS in order to check the bending at
half of the tube length and the inevitable stress concentrations that will arise due to the
slots. The variables L, c, a and R were adjusted systematically and the influence of these
changes were analysed in the FE-simulations.

The designs that fulfilled the criterions were manufactured and a preliminary compression
test was performed. The intentions of this test was to see whether the failure would occur
at the test section or not. If the failure were to occur at any other location, such as at
the edges of the tubes, the design would have to be discarded.

Two different specimen designs passed the preliminary compression test. The preliminary
test showed that these two specimen designs failed at or near the middle of the test
sections. The specimen dimensions are shown in Table 4.10, together with the bending,
according to Equation 4.8, estimated by the LUSAS FE-model.

Table 4.10: Test specimen dimension variables

Dimensions [mm] Bending [%]
L R c a d

Specimen design 1 90.0 30.0 20.0 37.5 39.0 38.2
Specimen design 2 90.0 20.0 20.0 37.5 39.0 6.6

The reasoning behind choosing two different specimen designs is that specimen design 1,
with the larger hole radius will have less influence from the stress concentrations caused
by the slots, explaining why it was decided to keep the design even though large values
of bending had been predicted by the FE-model. While specimen design 2 has a smaller
hole radius and wider test sections. This should cause more stress concentrations from
the slot. At the same time the wider test sections should allow for less bending during
the test. The method used to evaluate the bending is covered in Section 4.4.2.

In addition to the two specimen types with slots, tubes without slots were also tested in
order to find the compression stiffness of the laminate.

4.4.2 Compression test procedure

The final compression tests were performed at Chalmers University of Technology using
an Instron 400RD compression testing machine. The machine was configured to apply a
load at a constant crosshead displacement rate of 1.3 mm/min, according to the ASTM
D695 standard (ASTM D695-15, 2015). The load was then measured by the machine’s
software at a sample frequency of 10 Hz. During the tests, strain gauges are mounted
on the inside and outside of the test sections to measure the bending during the tests,
Figure 4.11. The data from these strain gauges was logged with a sample frequency of
50 Hz.

The specimen with slots were loaded until a significant load drop occurred, accompanied
by a loud cracking noise, the load Fmax is documented at failure. From the strain gauge
data the compressive strength and bending (Equation (4.8)) of the specimens were calcu-
lated. The strain at the tabs was calculated for port and starboard side of the specimen,
as the mean of the strain at the inner and outer surfaces. Port and starboard is denoted
by the index P and S respectively.
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εi = ε1i
+ ε2i

2 i = P, S (4.9)

With the strain at the tabs the load at each tab was calculated

Fi = εi
εP + εS

i = P, S (4.10)

Finally the compressive strength is determined by dividing the maximum force acting on
either of the tabs, with the cross section area of a single tab, Atab.

XC = max (FS, FP )
Atab

(4.11)

Figure 4.11: Schematics of strain gauges and loads acting on test specimen.

No strain gauges were fitted on the tubes without slots. The load and displacement of
the load cell was logged during the tests of the solid tubes.
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5.1 Circular cross-sectional models

Regarding the results from the simulations and benchmark tests of the circular cross-
sections, it has been reasoned that the FE-simulations, the benchmark tests and the
comparison between the two serves as a proof of concept. In the following sections it
will be shown that a good correlation between simulations and benchmark tests has been
shown to exist. The statement is true for both spinnaker poles, and the hybrid laminate
tube. This indicates that material properties of the laminates have been approximated
sufficiently accurate and that the FE-models are accurate enough to produce results that
predict the stiffness of the cross-sections in a consistent and satisfying way.

5.1.1 Spinnaker poles benchmark test results

In Table 5.1 and 5.2 the test results for pole 39 and pole 88 is presented, respectively.
During the testing of pole 39, a loud and clear cracking sound was heard when the load
reached approximately 1700 N . The load was immediately decreased once the noise was
heard. No damage indicating failure could be seen on the pole. After the test the pole
was checked for internal damage by tapping a coin on the surface to hear differences in
the sound due to delamination. No damaged zone could be found with this method.
Further investigations will be required to find the cause of the cracking sounds. As for
pole 88, no cracking sounds or other indications of failure were noted during the test.

It can be seen in Tables 5.1 and 5.2 that the deflection is more or less identical for AL/AR
and BL/BR in every load increment. It can be concluded from the tables that symmetric
deflection around the mid-point has been achieved with satisfactory accuracy. Therefore,
the mean deflection of both sides is calculated for each load increment according to
Equations (5.1) and (5.2).

Table 5.1: Pole 39 test results

Deflection [mm]
Load [N] AL BL C BR AR

265 15 20 22 20 15
452 24 33 37 33 25
658 37 49 54 49 37
913 49 66 72 65 48
1120 63 82 90 82 63
1375 75 100 112 101 76
1591 88 118 130 118 89
1159∗ 65 87 95 87 65

∗ measured after cracking sound
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Table 5.2: Pole 88 test results

Deflection [mm]
Load [N] AL BL C BR AR
1061 24 31 35 31 24
1611 37 48 52 47 36
2121 47 62 69 62 46
2612 57 76 84 77 57
3084 69 91 100 90 67
3683 82 108 119 109 82
4193 93 124 137 124 93
4812 108 144 157 143 107
6030 136 181 198 180 136

Ai = ALi + ARi

2 (5.1)

Bi = BLi +BRi

2 (5.2)

The results of Equation (5.1) and (5.2) are presented in Tables 5.3 and 5.4. Since the
mean values are nearly identical with the original measured values of AL, AR and BL,
BR all further analysis and comparison of test results will be according to these values.

Table 5.3: Pole 39 mean values of test results

Deflection [mm]
Load [N] A B C

265 15 20 22
452 25 33 37
658 37 49 54
913 49 66 72
1120 63 82 90
1375 76 101 112
1591 88 118 130
1159∗ 65 87 95

∗ measured after cracking noise

In Figures 5.1 and 5.2 the values of Tables 5.3 and 5.4 are plotted against the load for
both poles.
In Figure 5.1 the load and deflection follow a linear relation. In Figure 5.2 this linear
relation is more obvious. Since both poles are of the same material, shape and loaded
in the same configuration it can be concluded that a linear relation between load and
deflection exists in both cases. Larger deviations from this linear relation in Figure 5.1,
is most likely explained by measuring errors. Since it was concluded in Table 5.1 and 5.2
that near exact symmetric deflection around the mid-point has been achieved, the mean
of AL and AR will simply be referred to as the deflection in point A. Likewise the mean
of BL and BR will be referred to as deflection in point B.
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Table 5.4: Pole 88 mean values of test results

Deflection [mm]
Load [N] A B C
1061 23 31 35
1611 36 48 52
2121 47 62 69
2612 57 77 84
3084 68 91 100
3683 82 109 119
4193 93 124 137
4812 108 144 157
6030 136 181 198

Figure 5.1: Pole 39 load vs deflection test results.

5.1.2 Comparison of spinnaker poles test results and FE-simulations

In Figures 5.3 and 5.4 the extrapolated test data can be seen plotted together with the
results from the FE-model explained in Section 4.1.4. Further, in the previous section,
it was concluded that the load and deflection follows a linear relation the load-curves
can be extrapolated so that they originate from the origin. In Figures 5.5 and 5.6 the
normalised difference between LUSAS and test results in points A, B and C are plotted
according to Equation (5.3).

δ = wi,FE − wi,test
wi,FE

(5.3)

The variable wFE is the deflection calculated by the LUSAS model and wtest is the de-
flection measured in the tests. Thus positive values indicate that the deflection predicted
by the LUSAS model is larger than test results, and vice versa for negative values.
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Figure 5.2: Pole 88 load vs deflection test results.

Figure 5.5: Pole 39 normalised difference between LUSAS and test results.

In Figure 5.5 the difference between the LUSAS model and the measured test results
for pole 39 varies between 1.2% to 10.0%. The 10.0% peak in difference at 913 N of
load is probably due to a measurement error. The other exception is the relatively small
difference of 1.2% to 2.2% recorded at the lowest load of 265 N. However, for remaining
load increments the difference varies between 4.5% to 7.2% which has to be considered
to be within acceptable margins.
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Figure 5.3: Pole 39 test results and LUSAS results.

Figure 5.6: Pole 88 normalised difference between LUSAS and test results.

For pole 88 the differences vary less compared to pole 39. The same trend can be seen
with small differences for the smallest load applied in the test. However no clear peak in
differences is recorded here. If the minimum of 0.2% for the midpoint at 1061 N and the
maximum 6.0% for point A at 2612 N is excluded, the difference between LUSAS model
and test results varies between 2.8% and 5.1%. Again the LUSAS model is considered to
match the test results with acceptable accuracy.
In Table 5.5 the results of the linear regression on the mid-point deflection is shown. In
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Figure 5.4: Pole 88 test results and LUSAS results.

the table it can be seen that the load and deflection follows a linear relation, since ρ is
close to 1 for both poles.

Table 5.5: Results of linear regression of test results.

Test results µwmid
[mm] σwmid

[mm] µF [N] σF [N] ρ [-] k [mm/N]
pole 39 76.26 37.30 95.88 46.62 0.9995 0.7997
pole 88 105.34 52.45 330.44 162.74 0.9999 0.3223

In Table 5.6 the linear regression of the LUSAS results is shown. The results show that
the LUSAS results follow a linear relation.

Table 5.6: Results of linear regression of LUSAS results.

LUSAS results µwmid
[mm] σwmid

[mm] µF [N] σF [N] ρ [-] k [mm/N]
pole 39 75.46 44.56 89.52 52.37 1.0000 0.8508
pole 88 115.38 66.92 347.82 199.79 1.0000 0.3350

Figures 5.7 and 5.8 shows the mid-point deflection linear regressions of LUSAS and test
results, plotted together with Equation (4.6) for pole 39 and pole 88.
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Figure 5.7: Pole 39 linear regression of LUSAS and test results.

Figure 5.8: Pole 88 linear regression of LUSAS and test results.

With the values in Tables 5.5 & 5.6 and Equations (4.5) & (4.6), the difference between
test results and LUSAS results can also be represented using Equation (5.4).

∆ =
(
kLUSAS
ktest

)
− 1 (5.4)

Equation (5.4) gives the results presented in Table 5.7.
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Table 5.7: Difference between LUSAS and test results

∆ [%]
Pole 39 6.39
Pole 88 3.94

5.1.3 Comparison of hybrid laminate tube test results and FE-
simulations

In Section 4.1.2 test results from three point bend tests performed on a hybrid laminate
tube were presented. In this section a comparison between these test results and the
results of the FE-simulations is made. In Table 5.8 the results from the tests and FE-
simulations are presented and compared. In Table 5.8 the average deflections of all 53
bend tests are presented.

Table 5.8: Results of Seldén hybrid laminate tube tests and simulations.

Lspan/4 Lspan/2 3Lspan/4
wtest [mm] 26.3 38.5 26.3
wFE [mm] 27.9 41.0 27.9

Difference [%] 6.08 6.49 6.08

It can be seen that the difference between simulation and test results are small and on the
same side as the previous results obtained for the circular poles. Since the hybrid laminate
tube FE-model was modelled using the same methodology as applied to the spinnaker
poles, one can argue that the results is another argument that the FE-models are accurate
for determining stiffness. Furthermore, in Section 2.2.4 material properties for the hybrid
laminate were calculated. These properties have now been shown to produce deflections
in the FE-simulations that are close to the measured deflections in the test. This indicates
that the method to calculate the properties of the hybrid laminate in Section 2.2.4 is a
valid method in this case. However to implement the method on an arbitrary hybrid
laminate, i.e. a laminate with three constituents instead of the usual two, more tests
should be performed.

5.1.4 Fibre angle analysis

After measuring the fibre angles of the tubes according to the method described in Section
4.2.2 it was concluded that the nominal wind angle and the actual wind angle was the
same with very small variations. The actual wind angle was within one degree of the
nominal wind angle in all observations.

5.1.5 Summary of circular cross-section results

The results of the circular cross-section models and tests have shown that the FE-
simulations of the benchmark test have produced results that are close to the measured
values. It is concluded that the methodology applied to create the FE-model is suffi-
ciently accurate to be applied, with confidence, also to the non-circular cross sections.
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However, minor modifications will have to be made to take some of the features of the
non-circular cross-section into consideration. It has also been shown that the material
properties used in the FE-models produce results that gives good correlation with the
tests. It can be concluded that these material properties are sufficiently accurate to de-
termine the bending stiffness of the laminates. This statement can be considered to be
true for the T700SC/UF3325 TCR material properties that were supplied by Seldén as
well as the hybrid laminate material properties that were calculated in Section 2.2.4.

5.2 Non-circular cross-section model

The tests performed at SML show an interesting behaviour where two of the three masts
deflect asymmetrically on port and starboard side. Possible explanations for this will be
discussed further in Section 6.2. Tables 5.9 to 5.11 show the results for all three masts
tested at SML.

Table 5.9: Loads and deflections for the Sea Racer 35 mast, showing the asymmetric
deflection.

Deflection of Sea Racer 35 mast [mm]
Load [N] Port down Starboard down Aft down

0 54 65 26
98.2 78 95 38
196.4 110 124 51
294.6 139 152 63

Table 5.10: Loads and deflections for the Farr 58 Maiden mast, showing the asymmetric
deflection.

Deflection of Farr 58 mast [mm]
Load [N] Port down Starboard down Aft down

0 8 13 -
117.9 9 15 -
216 12 18 -
314.2 13 20 -
412.4 16 23 -
510.6 18 25 -
608.8 20 27 -
741.4 23 30 -

The three masts have also been analysed in LUSAS where the bending was tested with
the mast laying on its aft for the Sea Racer and the J70, and on its sides for all three
masts. The FE-model was only tested on one side since the results proved to be entirely
symmetric for both port and starboard. This symmetry was confirmed by varying the
thickness and fibre angles in LUSAS according to the observed variations that the masts
showed in reality. The results from the FE-models are shown in Figures 5.9 to 5.11.
The diagrams show a a fairly good match between the test results and the FE-results, with
some deviations due to initial deflection. The conclusion is that comparing the deflections
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Table 5.11: Loads and deflections of the J70 mast.

Deflection of J70 mast [mm]
Load [N] Port down Starboard down Aft down

0 0 0 0
117.8 13 14 10
216 24 25 18
314.2 36 38 25
412.4 48 50 33
608.8 - - 50

Figure 5.9: Sea racer 35 bend test results

in absolute numbers is not representative for the stiffness of the masts. Instead, a linear
regression analysis identical to the one in Section 5.1.2 is performed on the test and FE-
results. Assuming that the deflection curves, and thus also the stiffness, are still linear
or close to linear for the non-circular sections, the regression will give k-values that will
be directly comparable as a measure of the stiffness. Table 5.12 shows the results of this
comparison, calculated using Equation (4.5).
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Figure 5.10: Farr 58 Maiden bend test results

Table 5.12: Stiffness comparison, FE vs. tests

Load case Difference in stiffness [%]
Searacer 35 - Aft 4.8
Searacer 35 - Starboard 11.4
Searacer 35 - Port 12.5
Farr 58 - Starboard 0.3
Farr 58 - Port 12.4
J70 - Aft 0.0
J70 - Starboard 10.5
J70 - Port 15.1

The values in Table 5.12 indicate that the FE-results are consistently less stiff than the
test results, which was also the conclusion from the circular cross-sections. Unfortunately,
the difference for the non-circular cross-sections are larger and vary from 0 to 15%.
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Figure 5.11: J70 bend test results

5.2.1 Fibre angle analysis

The results of the fibre angle analysis of the non-circular tubes proved to be harder to
interpret than for the circular tubes. Several tracings were made on different tubes, and
the conclusion was that the fibre angle does change slightly around the aft corners of the
mast section. It was concluded that the fibre angle in this area may change between ±4◦.

This variation in fibre angle was taken into consideration and tested in LUSAS, but the
results showed negligible effect on the overall stiffness of the masts. It was decided to
simply use the nominal wind angle in all simulations.

5.3 Out of plane waviness of fibres

Portions of the micrograph specimens of the laminate are shown in Figure 5.12. These
are the micrographs that are analysed with the HRMA method (Wilhelmsson & Asp,
2018). When observing the micrographs the five layers, one −◦6 and two −◦, can be
distinguished. The −◦ ply can be seen in the bottom of each micrograph. The fibres in
the −◦ layers appear light and oval shaped in the micrographs while the resin surrounding
the fibres appear in a darker shade. These micrographs are then assembled into one, where
approximately 40 individual micrographs were required to capture the entire specimen.

In Figure 5.13 the distribution of the fibre misalignment in each specimen is plotted.
In these plots the magnitude of the fibre misalignment is shown. The difference in fibre
misalignment direction between −◦ and −◦ layers is clearly visible, especially in specimen

6Sensitive information has been censored in the published version of this thesis
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(a) Specimen A1 (b) Specimen A2

(c) Specimen B1 (d) Specimen B2

Figure 5.12: The micrographs sample

A1. The nature of the filament winding process creates this pattern where the direction
of the fibre misalignment is related to the fibre direction in each layer. At the bottom
of each plot it can be seen that only a few measurements are taken in the −◦7 layer.
This is expected since the HRMA is capable of identifying fibres that are oriented in the
sectioned plane.

From the distributions in Figure 5.137 the mean fibre misalignment angle θ and stan-
dard deviation of fibre misalignment angles σθ can be calculated. The maximum fibre
misalignment angle θ99 is calculated as the 99-percentile of the distribution of angles as
proposed by Wilhelmsson et al. (2018). The results are presented in Table 5.137 below.

7Sensitive information has been censored in the published version of this thesis
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(a) A1

(b) A2

(c) B1

(d) B2

Figure 5.13: Distribution of fibre misalignment in the laminates.

Table 5.13: Results of fibre misalignment image analysis

Specimen8

A1 A2 B1 B2
θ [°] - - - -
σθ [°] - - - -
θ99 [°] - - - -

The mean misalignment θ and maximum fibre misalignment θ99 vary between −◦ −−◦8

and −◦ − −◦8 respectively. This variation is to be expected due to the local variations
of the fibre waviness in the masts, and also due to the fact that the mast has been
sampled at different locations. The angles presented in Table 5.13 can be related to the
classification of waviness magnitude levels in the study by Wilhelmsson and Asp (2018),
where a distinction is made between moderate and high levels. The angles in Table 5.13
would then be considered as very high.

8Sensitive information has been censored in the published version of this thesis.
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5.4 Compression test results

The results from the compression tests can be divided into three groups, one for each
type of specimen geometry. The data consists of a load/displacement diagram as well
as a strain/time diagram. The solid tubes were tested without strain gauges and will
therefore not have any measured data on strain. The stress at failure for each specimen
is presented in Table 5.14.
The three test specimens with a 30 mm slot diameter behave similarly in two of the
three tests with a failure load between — kN9. One of the test specimens appears to have
another stiffness with a slightly higher failure load of almost - kN as shown in Figure
5.149. This is possibly due to the fabrication method not being exact. The outlying
results may therefore be misleading.

Figure 5.14: Load curves for 30 mm specimen

After measuring the width of the specimen test sections, the total cross-sectional area in
the point of failure was calculated. The strain in each side of the specimen was found
and the failure load was divided proportionally based on the strain. The strain data is
found in Appendix A. The maximum of the two stresses obtained from each specimen is
then considered to be the failure stress.
Figure 5.159 shows that the 20 mm slot diameter specimen behave similarly regarding
the failure load, where the load is almost twice as high as for the 30 mm specimen. The
same method of finding the failure stress that was used for the 30 mm specimen is used
here.
The solid tubes without slots were primarily tested to find the compressive stiffness of the
tube. This was done by first calculating the strain as the displacement (i.e. the distance
the load cell has moved) divided by the specimen length. The slope of a line close to

9Sensitive information has been censored in the published version of this thesis.
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Figure 5.15: Load curves for 20 mm specimen

the maximum load, where the slope is linear or close to linear, was then calculated using
Equation (5.5). The value obtained is the Young’s modulus for the specific specimen. It
is clear from Figure 5.1610 that this should give a quite accurate result since the curves
straighten out almost completely well before failure occurs.

Espec = ∆σ
∆ε (5.5)

Figure 5.16: Load curves for solid tube specimen

10Sensitive information has been censored in the published version of this thesis.
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5.4.1 Summary of compression test results

The compressive stress and bending at failure of the slotted tubes are presented in Table
5.1411

Table 5.14: Compressive stress and bending at failure

Xc [MPa] Bending [%]
Specimen 2 - 30 mm - 79.8
Specimen 3 - 30 mm - 44.2
Specimen 4 - 20 mm - 1.0
Specimen 5 - 20 mm - 8.7

The specimen with 30 mm hole diameter shows excessive bending at failure. The large
bending of these specimens make the results questionable. Specimen 2 is closer to being
subjected to pure bending than to pure compression. However, Specimen 4 and 5 fulfils
the criteria of less than 10% stated in (ASTM D3410/D3410M-16, 2016).
Figure 5.1711 shows the compressive strength plotted against the maximum fibre mis-
alignment angle. The Argon criteria has been plotted with an assumed lower and upper
bound of the composite shear yield limit. Except for specimen 3, the results seem to
agree with the lower bound of 50 MPa. Table 5.14 shows that specimen 4 and 5 are the
only specimens with allowable amounts of bending, 1.0% and 8.7% respectively. If only
these two specimens are considered valid, the experimental compressive strength of the
laminate is - MPa, calculated as the mean compressive strength of the two specimens.

Figure 5.17: Compressive strength plotted again the maximum angle together with the
Argon criteria.

11Sensitive information has been censored in the published version of this thesis.
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The stiffness found in the compression tests, shown in Table 5.1512, is quite close to the
given Young’s modulus of12 - GPa used in the FE-simulations for all three specimen.

Table 5.15: Experimental Young’s modulus in compression

Eexp [GPa]
Specimen 1 -
Specimen 2 -
Specimen 3 -
Mean value -

12Sensitive information has been censored in the published version of this thesis.
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6 Discussion
This chapter will treat some of the questions and thoughts that have appeared during
the project.

6.1 Circular cross-section model

Both the carbon fibre laminate poles as well as the hybrid laminate poles show consistent
bending behaviour in the tests, and the FE simulations manage to match the stiffness
of the poles within 6.5%. In all cases, the calculated stiffness is lower than the tested
stiffness. One could argue that lowering the stiffness in the FEA would make it possible
to match the tested stiffness even better. This would however mean that one of the initial
limitations of only using provided material data from Seldén would be disregarded. We
choose not to do this, but instead see the deviation in stiffness as an added safety factor
since if the maximum deflection is used as a design criteria, the FE simulations will always
show a larger deflection.

6.2 Non-circular cross-section model

The results covered in Section 5.2 show that the developed modelling method works con-
sistently for the non-circular mast when looking in the longitudinal direction. However,
the FE results and the test results can differ substantially when looking at port and
starboard side separately. It was also clear that the difference could be reduced by com-
paring the slopes of regression lines obtained from the raw test data. Using this way of
comparing stiffness reduced the difference between FE and reality to between 0 to 15%.
However, the numbers still show a difference between port and starboard, a fact that is
made even clearer by comparing the stiffness of the test data between the sides, as shown
in Table 6.1.

Table 6.1: Difference in stiffness between port and starboard of the test data.

Difference [%]
Searacer 35 1.0
Farr 58 12.1
J70 4.2

There is no clear answer to what is causing this asymmetric stiffness, but there are some
possible causes that have been observed during the thesis work. The simplest explanation
is that there may be inaccuracies in the test method. The masts that have been tested
may have been placed differently between measurements, and the measurements may
have some errors as well. A solution to this problem would be to conduct more tests on
masts to get an even larger sample population.
Other explanations that are not as simple have to do with the geometry of the mast itself.
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Some variations in the cross-sectional geometry as well as the global mast geometry has
been observed. One such variation is the laminate thickness around the circumference,
where some mast sections have shown different thickness in port and starboard sides. FE-
simulations have been made trying to take this asymmetric thickness into account, but the
results were symmetric. Another possible variation is the twist of the mast. A mast should
be as straight as possible after manufacturing, but some twist may still be introduced
during handling of the mast before curing the epoxy resin. Further investigations are
needed to reach a final conclusion regarding all of these theories.

6.3 Out of plane waviness of fibres

The HRMA method used to measure the out of plane waviness of the fibres was written
with the intent to measure the waviness of UD 0◦ fibres. In this project the waviness of
−13 plies was measured. The ability of the function to also be applicable to these type
of laminates is promising. The length of the projection of the fibres was enough to make
proper use of HRMA, a larger angle in plane would have made measurements impossible.

6.4 Compressive strength and stiffness

Due to the rather small number of specimens tested for compressive properties it is hard
to draw any certain conclusions. The higher failure load in combination with the low
percentage of bending indicates that the 20 mm hole diameter specimen produced a
more reliable result. This fact is also apparent in Figure 5.17 where specimen 4 and 5 lie
close to or within the approximated span of composite shear strength. If further testing
was to be performed, this geometry in combination with more precise machining would
most likely produce even better and more reliable results.

The compression test results over all are quite interesting, especially when compared to
previous research in the field. Argon proved in 1972 that there exists a relation between
the maximum angle and the resin shear limit of a composite (Argon, 1972). Argon based
his theory on an infinite rigid kink-band, the results obtained in this study show that
this theory is also applicable to a real composite. This study confirms the observations
by Wilhelmsson et al. (2018) in the sense that the maximum fibre misalignment angle
characterised with HRMA can be used in the Argon formula to accurately predict the
compressive strength in a robust manner. It is assumed and strongly believed here that
the kinking is out-of-plane, although this has not yet been verified.

6.5 Effects of corner over consolidation and varying
laminate thickness

The effects of over consolidation in the corners of the mast section and variations in the
laminate thickness around the section have also been studied during the thesis work. The
effect of these variables were found to have very little to no effect on the stiffness of the
mast when taken into consideration in the FE-simulations.

13Sensitive information has been censored in the published version of this thesis.
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As for the over consolidation of the corners, the small influence of this phenomena can
be explained by the fact that even though the laminate is thinner in the corner, the same
amount of fibres must be present here, and that the reduction of thickness is caused by
the fibres being more tightly packed in the laminate. This means that the same amount
of fibres are acting on approximately the same distance from the neutral axis as if the
corner had retained its nominal thickness throughout the corner. Therefore, one can
argue that the thinning of the laminate should not have any significant influence on the
overall stiffness. Unfortunately there was no time to examine the over consolidation with
microscopy.
The same argument can be brought on to any variation of the thickness around the
section. Even if the laminate is thicker or thinner at any location, the amount of fibres
in the laminate must remain the same and the effect of varying distance to the neutral
axis can be neglected. In conclusion, it is possible to model the mentioned variations.
However, the time required and the added complexity to the model can not be motivated
with the small influence on the results.
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7 Conclusion
One of the main tasks in this master’s thesis was to develop a method for modelling
composite masts in the FEA software LUSAS. This has been achieved, where the method
can predict the bending of a pole or mast with an accuracy of more than 85%. The method
works consistently for circular poles, and for non-circular masts with some exceptions.
A modelling guide has also been written for future use at Seldén Mast. It will help the
company in future design work.
A consistent method to incorporate a second type of fibres to create a hybrid laminate
has also been developed. This opens up the possibility for Seldén to design mid range
products that have the benefits of a composite, but are not as expensive as the high end,
pure carbon fibre laminates. It also means that Seldén can experiment with the stiffness
of their products to tailor their behaviour to certain uses.
The use of micrography to measure the fibre waviness of a sample laminate from Seldén,
in combination with the HRMA method, gave a result that confirms the observations
by Wilhelmsson et al. (2018) in the sense that the maximum fibre misalignment angle
characterised with HRMA can be used in the Argon formula to accurately predict the
compressive strength in a robust manner. This is especially interesting since the tested
laminate comes from a regular product of Seldén’s, and not a laminate specifically made
for testing.
The method of obtaining the compressive strength of Seldéns filament wound laminates
was developed by the authors and the results indicate that the method may produce
relevant results. Of the two types of slotted specimens that were tested, the strain
readings show that the specimens with the smaller 20 millimetre slot were a lot less
prone to bending and thus closer to pure compression. Although it is a newly developed
method, it may still be of interest to further refine it.
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8 Future work
There are several aspects in both parts of the thesis that are yet to be investigated. These
aspects have been left out due to lack of time, or due to the fact that they lie outside of
the scope of the thesis.

8.1 Stiffness modelling

As mentioned in Section 5.2, a difference in stiffness between starboard and port was no-
ticed when testing the masts. The reason for this behaviour was not entirely established,
which is why this question needs further investigation.

8.2 Compressive strength

Although the compressive tests showed signs of fibre kinking, it still needs to be confirmed
that fibre kinking is the failure mode in order to validate the assumed failure criteria.

8.3 Dynamic simulations of mast and rig

Dynamic loads are accounted for in the design process of a mast at Seldén. However, sim-
ulations of the rig together with dynamic loads deriving from the sea-keeping properties
of the hull in waves, as well as wind loads from the sails, is an area where further devel-
opments can be done. Such a project would require the use of theories in computational
fluid dynamics (CFD), as well as in finite element analysis. Loads can be derived from
CFD analysis of a hull moving in waves as well as from the pressure distribution around
the sails. These loads can then be simulated in a FE software to find the response of the
mast and rig. Such investigations would improve the understanding of how hull shapes
and sail design influences the mast and rig. In addition, it would open up the possibility
of optimisation of mast and rig, taking into account the design of hull and sails.

8.4 Modelling of torsional stiffness

Even though today, torsional stiffness of the mast is not considered to the same extent as
the bending stiffness, it does, to some extent; influence the behaviour and performance
of the mast. Better understanding of how the laminate can be optimised with regard
to both bending and torsion would open up the possibility of cheaper, more lightweight
and better performing masts. Similarly to how the bending stiffness was modelled using
FE-software, and benchmarked against three point bend tests, in this project. Tests and
models can be developed to derive the torsional stiffness of a carbon fibre laminate mast.
Masts of special interest in such a project would be masts with an open cross-section.
Such a cross-section could possibly exhibit significant warping effect, owning to the open
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cross-section. Investigations should be done, taking into account warping induced by the
laminate coupling stiffness matrix, as well as the warping due to the properties of the
open cross-section.
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A - Strain data
The strain data contains the data from all four strain gauges on one test specimen. It
has been adjusted to only show the strain during the actual load application until failure.
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A - Strain data

Figure A.1: Strain data for all 5 specimen with slots.
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B - LUSAS Modelling Guide
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Bending stiffness modelling of composite mast sections in LUSAS

1 Introduction

This document will give a step-by-step instruction on how to model bending stiffness of composite mast
sections in LUSAS, following the procedure developed by Eric and Emanuel in the master’s thesis work
in 2018.

The instruction covers everything from importing and/or creating and defining the initial geometry,
applying loads and boundary conditions, to post-processing and finding the values of interest. However
it is recommended to do the tutorials available in LUSAS first in order to learn the basics of the software.

In the end of the document there will be a short guide on how to use the results in hand calculations
to verify the results. There is also a checklist for checking your own setup for errors or mistakes.
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2 Preprocessing

In this section the FE-modelling of a thin-walled composite structure subjected to bending will be
explained. The method is first and foremost meant to explain the method of modelling stiffness of a
mast or a spinnaker boom. However, the method could be applied to any structure similar to these.

2.1 Geometry and Attributes

When modelling the geometry of the mast, the starting point is the geometry of the mandrel on which
the mast in question is wound on. The outline of the mandrel section is imported into LUSAS. Figure
1 shows the mandrel outline, as it is when imported into LUSAS

Figure 1: Mandrel outline as imported into LUSAS.

LUSAS might experience some difficulties with the imported geometry. According to the LUSAS
support this is a known issue when importing geometry from AutoCAD into LUSAS. LUSAS says that
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they have initiated a change request to solve this problem. Hopefully in future versions of the software
this is not an issue anymore. However, the easiest way to solve this problem at the moment is simply
to redraw the geometry using the imported geometry as a template.

As the outline is redrawn points are added on the section sketch to represent the B-lines, the fore line
and the aft line. Further points are also added to represent the areas of the mast that are reinforced
with UD tapes. Figure 2 shows the original points, together with all the points added in the redrawing.

Figure 2: Redrawn mandrel outline.

Some of the points in Figure 2 are the original points from the imported geometry while others are
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added in the process of redrawing the outline in LUSAS. The mast section shown in Figure 2 has
UD tape reinforcements on all four sides. The width of these reinforcements is known, why they can
be defined in the section geometry. Later on, composite layups will be defined to represent the UD
reinforcements, see Section 2.4 for more on defining composite layups. Further, both aft, forward and
B-lines are added into the section geometry as points. Below follows a list with detailed information
on each point in Figure 2.

Point 1 defines the forward line of the mast.

Point 2 defines the width of the forward UD tape reinforcements.

Point 3 is a point from the original imported geometry.

Point 4 together with Point 6 defines the width of the starboard and port UD tape reinforcement.

Point 5 defines the location of the B lines.

Point 6 see Point 4. Also defines the width of the aft UD tape reinforcements.

Point 7 Point from the original imported geometry.

Point 8 Point from the original imported geometry.

Point 9 Point from the original imported geometry.

Point 10 Defines the aft line of the mast.

Since the structure can be considered to be thin-walled it will be modelled using surfaces. The surfaces
are created by sweeping the lines and points that make up the cross-section of the mast to the desired
length. When creating the surfaces by sweeping, it is important to keep in mind where the loads and
supports are located. Most often, to be able to apply either a load or a support at a certain location
on the geometry, either a point or a line will be needed at this location. In Figure 3, a mast is shown
where the load is applied on a line located at the mid-span between the supports. In the same figure
the supports are defined by points located on the bottom surface of the mast. The figure shows one
example on how points and lines can be used to create geometry that later on will be used to define
loads and supports. In Figure (3) the geometry was created by sweeping the lines of the mast section
four times.
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Figure 3: Lines and points used to define load and supports.

The surfaces need to be assigned a thickness. To do this got to: Attributes > Geometric > Surface.
The dialog window in Figure (4) below will appear.

Figure 4: Definition of surface thickness and eccentricity.

The wall thickness of the mast section is entered in the field Thickness. Since the mast section was
drawn with the mandrel as reference, all surfaces will automatically be the inner surfaces of the section.
LUSAS will model the laminate using these surfaces as mid-surfaces if nothing else is specified. This
means that surfaces need to be given an eccentricity of half the laminate thickness. In the field
Eccentricity enter the value:

ez = −t

2
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In this equation, t is the wall thickness of the surface. The normals of the surfaces should be pointing
outwards and away from the midpoint of the mast section. If this is the case, given that the eccentricity
is negative, the thickness of the surface is moved outwards, as intended. See Section 2.6.3 on how to
orient the normals of the surfaces. To check if eccentricity is correct turn on Fleshing and observe in
what direction the thickness of the surface is moved when the eccentricity value is entered. Figure 5
below shows the surfaces of a section with the correct eccentricity. The red points reveal the location
of the surfaces.

Figure 5: Correctly defined eccentricity.
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2.2 Effects of corner over consolidation and varying laminate thickness

In the master thesis work written in ad junction to this modelling guide the effects of over consolidation
in the corners of the mast section and variations in the laminate thickness around the section was
studied. The effect of these variables were found to have very little to no effect on the stiffness of the
mast.

As for the over consolidation of the corners, the small influence of this phenomena can be explained
by the fact that even though the laminate is thinner in the corner, the same amount of fibres must
be present here, and that the reduction of thickness is caused by the fibres being more tightly packed
in the laminate. This means that the same amount of fibres are acting on approximately the same
distance from the neutral axis as if the corner had retained its nominal thickness throughout the corner.
Therefore one can argue that the thinning of the laminate should not have any significant influence on
the overall stiffness.

The same argument can be brought on to any variation of the thickness around the section. Even if
the laminate is thicker, or thinner; at any location the amount of fibres in the laminate must remain
the same and the effect of varying distance to the neutral axis can be neglected. In conclusion, it is
possible to model the variations mentioned in this section. However, the time required and the added
complexity to the model can not be motivated with the small influence on the results.

2.3 Composite Material Definition

The carbon reinforced plastic is defined as a solid orthotropic material in LUSAS. To do this go to:
Attributes > Material > Orthotropic
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Figure 6: Plane stress orthotropic material definition dialog window.

By default LUSAS will open the dialog window for a Plane stress material model shown in Figure 6.
Change the material model to Solid from the drop down menu to the left in the window.
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Figure 7: Solid orthotropic material definition dialog window.

This will open the dialog window shown in Figure 7. In Table 11 the material data to be entered into
the window in Figure 7 is shown. If the model is in millimeters (which is usually the case), be aware
that Mass density must be entered in the unit t/mm3 and the modulus must be entered in MPa here.

Table 1: T700/UF3325 Material data

Value
Young’s modulus x - MPa
Young’s modulus y - MPa
Young’s modulus z - MPa
Shear modulus xy - MPa
Shear modulus yz - MPa
Shear modulus xz - MPa
Poission’s ratio xy -
Poission’s ratio yz -
Poission’s ratio xz -

Mass density - t/mm3

1Censored for publication.
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Name the laminate material after its constituents i.e fibre name/resin name. To finish editing the
material click OK in the dialog window.

2.4 Composite Layup Definition

To define a composite layup go to: Attributes > Composite.

Figure 8: Selecting the type of composite layup to be created

The window shown in Figure 8 will appear. Select Solids and Shells and click Next to proceed.
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Figure 9: Composite definition dialog window

Figure 9 shows the composite layup definition dialog window. In LUSAS layups are defined from
bottom to top in the same direction as the normal of the surface that the layup is assigned to. See
Section 2.6.3 for more on normals and normal orientation.

Start defining the first layer by clicking New at top right. To define a layer, enter a name for each layer
in the Name field. From the Material drop down list select the material to be assigned to the layer. In
the Thickness field enter the layer thickness as a fraction of the total number of layers according to:

Thickness = 1
Total no. of layers

In Angle enter the fibre orientation of the current layer in degrees, relative the long axis of the mast.
The Volume fraction field is optional and will not influence the solution in the analysis intended for
this model. To finish the current layer and start defining next click Apply in the bottom right of the
window and repeat the process for the next layer. When all layers have been defined click Finish to
close the dialog window. To inspect or change the definition of the layup right click on the layup in
the Attributes tree to open the dialog window again. In the top right corner it is possible to toggle
through the layers to view or edit them individually. The Visualize button gives a visual overview of
the layup.

To assign the layup to a surface simply select the surface to which the layup is to be assigned and drag
and drop the layup from the Attributes tree. The dialog window shown in Figure 10 will appear.
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Figure 10: Composite assignment dialog window

Important! Make sure that Assign to surfaces is selected and that the orientation of layup is set to
Local element axes as shown in Figure 10. This option makes sure that the layup uses the orientation
of the element axes as reference for the fibre angles. Consequently, the orientation of the element axes
must be correct for the fibre angles to be correct. See Section 2.6.3 on how to orient the element axes.

If the mast has UD reinforcements the easiest way to include these in the model is to create several
composite layups, following the same procedure as previously. In Figure 28a2 a nominal layup is shown
next to an UD reinforced layup in Figure 28b2 where the UD reinforcements are visualized as yellow
blocks in the stack.

(a) Nominal composite layup (b) Reinforced composite layup

Figure 11: Examples on nominal and reinforced composite layups

The layup including the reinforcements is then assigned to the surfaces where the UD tapes are located
on the mast, and the nominal layup is assigned to all surfaces with no reinforcements. In Section 2.1

2Censored for publication.
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surfaces where UD reinforcements are located were defined by adding points on the geometry of the
mast section. Remember to also adjust the thickness in the areas where additional fibre layers have
been applied.

2.5 Loadcase

The loadcase is defined as the applied load and the boundary conditions of the geometry. In this
section only the load types and boundary conditions used in the thesis will be described. They are
based on a beam that is freely supported at both ends, loaded in three-point bending by hanging a
weight in a strap around the circumference of a mast or boom. The load is applied centered between
the supports.

2.5.1 Boundary Conditions

To avoid any distortions or unnatural behaviour of the mast close to the supports, the boundary
conditions are applied in single points (such as Point 10 or 5 in Figure 2), instead of along a line or on
a surface.

One support will be fixed in translation in all directions, as well as rotation around the long axis of
the mast. The other support will have the same settings except that it will be allowed to translate
along the axis of the mast. In Figures 12 and 13 the z-axis aligned with the long axis of the mast.

To define a support, go to Attributes > Support and apply the settings shown in Figures 12 and 13.
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Figure 12: Settings for right support.
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Figure 13: Settings for left support.

2.5.2 Applied Loads

The load is applied as a line load in the position on the mast where the actual load would be applied.
In the case of a circular cross-section, the line would run across the tube along the upper half of the
circumference. If the line is not split in several parts, the load can be applied as Global Distributed.

To create a load, go to Attributes > Loading and pick Global Distributed. The dialog window should
look similar to the one shown in Figure 14.

Example: If the load is 20 kg, the load will be defined as a total global load of 196.4 N. LUSAS will
then take care of the distribution along the line.
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Figure 14: dialog window for defining a load.

If the upper half of the circumference of any cross-section is split into several smaller lines of differing
size as in Figure 15, the easiest way to apply the load is to sum the length of the lines, divide the total
applied force per unit length and then define the applied load as Per unit length. The load distribution
will then be correct for that specific group of lines. To see the length of a line, hover the mouse pointer
on top of it. This is also shown in Figure 15.

Example: The applied load is 20 kg. Several smaller lines make up a total length of 85 mm. The
load per unit length is then 196.4 N divided by 85 mm, 2.31 N per unit length. To apply this load
correctly, select all the lines that make up the total line, and apply the unit length load.
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Figure 15: Division of lines and how to see their length.

If desired, gravity can also be applied on the entire model. Gravity is defined by clicking File > Model
Properties. The dialog window in Figure 16 should appear. Gravity is defined in mm/s2. In order for
the analysis to take gravity into account, it also needs to be explicitly applied in the loadcase. Do this
by right-clicking the loadcase in the Analysis tree and mark Gravity.

Figure 16: Dialog window for defining model gravity.
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Figure 17: Applying the gravity option to the loadcase.

Note! Applying gravity demands a correct density of the material used in the model to give a correct
result.

When defining any load, make sure that it is applied in the desired direction. Check along which axis
it is applied, and if it should be defined as negative or positive.

2.6 Meshing

The meshing of the model defines the element type to be used in the analysis as well as the grid size
of the mesh. Making a bad choice for the mesh can give bad results.

2.6.1 Elements and Limitations

The elements that have been used in all analyses are quadrilateral shell elements with quadratic
integration points (QTS8). These elements are suitable for thick-shelled geometry with little or no
out-of-plane stresses.

To define the elements to be used in the mesh, go to Attributes > Mesh > Surface. Apply the setting
according to Figure 18.
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Figure 18: Mesh settings dialog window.

2.6.2 Element size and Convergence

The element size should be chosen such that the elements do not have an aspect ratio that is too large,
i.e. one side should not be excessively larger than the other. If this is the case in any point of the
mesh, the solver will give warnings. Choose element size so that the elements are close to square and
the solver gives no warnings.

The grid size should also be chosen such that the results have converged and are size-independent.
To check this it is recommended to do a convergence check where the element size is incrementally
lowered until the results do not change with a change in element size. The result to be checked can be
any result, e.g. the mid-point deflection or maximum stress.

The grid size of the mesh is controlled with the settings shown in Figure 19, found by going to Attributes
> Mesh > Surface, or by editing an already existing mesh attribute. Figure 20 shows an element that
will most likely render a warning in the solver due to the high aspect ratio.
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Figure 19: Mesh element axes.
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Figure 20: Bad element with high aspect ratio.

2.6.3 Element orientation

In Section 2.4 the Composite layup was set to use the local element axes as reference for the fibre
angle. To visualize the element axes make sure that the model is meshed. Right click on Mesh in the
Layers tree and select Properties. The following window will appear Figure 21
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Figure 21: Mesh element axes.

Make sure that the Show element axes box is selected and click Apply. The element axes will now
appear on the mesh as shown in Figure 22.

Figure 22: Mesh element axes.

For consistent modelling reasons the normal’s of all surfaces on the mast should be pointing outwards
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away from the midpoint of mast section. To reverse the normal of a surface: select the surface you
wish to reverse and go to: Geometry > Surface > Reverse. Repeat the process until all surfaces are
pointing outwards as shown in Figure 23

Tip! Every time a surface is reversed (or cycled) the mesh has to be recalculated. To reduce the
calculation time of each reverse operation, temporarily change the mesh size to a larger element size.

Figure 23: Correct surfaces normal orientation.

In Section 2.4 the fibres of the composite was set to use the orientation of the element axes as reference.
Consequently, to get the correct orientation of the fibres, correct orientation of the element axis must
be achieved. To have consistent fibre orientation in the model, all double headed arrows (Figure 22)
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must be aligned with the long axis of the mast. Usually this is achieved by manually changing the
orientation of all surfaces in the model. To change the orientation of a surface: select the surface you
wish to change the orientation of, and go to Geometry > Surface > Cycle. The following window will
appear:

Figure 24: Surface cycle dialog window.

Click Apply to cycle the surface until the double headed arrow is aligned with the long axis of the
mast. Repeat the process until the double headed arrow of all surfaces in the model is aligned, in the
same direction, with the long axis of the mast.

With the settings specified in this document, LUSAS uses the axis marked with a double headed arrow
as reference for the fibre angle. This means that a composite layer with 0◦ fibre angle will be aligned
with the double headed arrows as shown in Figure 25, where the fibre direction is visualized with
purple arrows, on top of the element axes plotted with grey arrows.

Figure 25: Composite 0◦ fibres .

Figure 26 on the other hand shows a surface with −◦ fibres visualized with purple arrows.
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Figure 26: Composite −◦ fibres .

To visualize the fibre orientations as in Figure 25 and 26 right click on Attributes in the Layers tree
and click on Properties. In the window that appears click on the Composite tab to get to the window
shown in Figure 27 below.

Figure 27: Fibre visualization dialog window.

Select all the Layups in the list and click OK. Then go to the Attributes tree and expand the layup you
wish to visualize by clicking on the plus sign next to the name of the layup. Right click on the layer
you wish to visualize in that layup and select Set Lamina Active as shown in Figure 283

3Censored for publication.
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(a) (b)

Figure 28: Visualizing a certain layer in the model.

Only one layer layer in one layup can be active at a time. To inspect another layer in the same or
another layup, simply repeat the process for that layer.

2.7 Solver Setup

The solver is set up before starting the analysis to assure quick and good convergence. Applying bad
settings can result in an analysis that exits with errors or that takes unnecessarily long time to finish.
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2.7.1 Non-linear controls

All analyses have been run as non-linear and transient in order to catch any non-linear behaviour in
connection to the deformation of the cross-section of the mast. This means that the analysis will be
run in several increments from almost no load up until the nominal load defined in the model setup.
In order to get the analysis to run smooth and converge easily, a number of setting should be changed.
These settings have been recommended by the technical support at LUSAS. The nonlinear controls are
accessed by right-clicking Nonlinear and Transient found in the Analysis tab in the treeview, shown
in Figure 29.

Figure 29: Nonlinear controls are found in the analysis tab in the treeview.

Use the same settings as the ones shown in Figure 30. The settings below mainly aim to:

• Remove arc-length solution by setting it as zero.

• Start with a load factor of 0.1, which can increase without restriction (o) until final solution
reaches total load factor of 1.

• Adjust load factor based on how "easy" or how "difficult" it was to converge in the first 4 iterations
of an increment.

• Set a more generous threshold of 0.5% for the residual force norm. This decides how good the
convergence needs to be for the analysis to move on to the next load increment.

• Ignore the incremental displacement norm (0), as it is the total displacement norm that generally
matters.
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Figure 30: Nonlinear controls.

Apart from this, a suitable mesh should have already been defined in the previous steps.

2.7.2 Inspection Locations

LUSAS gives the user the possibility to define specific inspection locations on the geometry where the
value of any parameter can be checked easily. This has been used in the thesis work to check the
deflection in two points on the bottom of the mast, to the left and right of the beam midpoint.

The inspection location(s) have been applied to existing geometry, either in points or on lines. To
apply an inspection location to a point, go to Attributes > Inspection Locations. The dialog window
that appears is shown in Figure 31.

In the dialog window you can choose to use either a Point, Line, Surface or Volume for the assignment.
If you choose Assignment to Point you press OK, select which point(s) you want to Inspect and then
drag and drop the inspection point in the same manner as the other attributes.

If the inspection location is to be placed somewhere on a line, select the Line radio button and define
the Distance type. The distance can either be defined as an actual distance along the line, or as a
fraction of the total line length.
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Figure 31: Inspection Location dialog window.
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3 Post-processing

Post-processing is carried out a after the analysis has been run. Most steps are the same regardless of
the analysis.

3.1 Contour plot

To view the results of the analysis, right-click in the graphics window and select Contour. To view
results in specific layers of the laminate layup, maximise it in the treeview and right-click the lamina
of interest. Click Set Lamina Active.

3.2 Model mass check

The mass of a model can easily be accessed from the model tree view after the analysis has been
run. The mass is printed in the model output file, which is opened by right-clicking Analysis in the
analysis tree view. Click View Solver Output File as shown in Figure 32. Search for the mass by
pressing Ctrl+F and search for "mass". The value is found under the headline Element Mass as shown
in Figure 33. The mass is shown in the unit tonnes.

Figure 32: Accessing the .out-file
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Figure 33: Mass information in the .out-file

3.3 Finding max stress and strain in a composite laminate model

In a LUSAS FE-model no differentiation will be made between stress or strain in resin and fibres. The
material properties defined in the pre-processing of the model in Section 2.4 is the properties of the
fibres and resin combined. Therefore the FE-model will approximate the material as homogeneous and
make no differentiation will be made between fibre and resin. In this specific example the procedure
to find maximum and minimum stress will be presented. The same procedure can be applied to find
the maximum and minimum strain.

To find the maximum stress or strain in LUSAS stress and strain for each layer has to be analysed
separately. To plot the stress or strain contours of a single ply got to the Attributes treeview. Expand
the composite layup definition and right click the ply you want to inspect, as shown in Figure 34.
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Figure 34: Selecting the active ply of a laminate.

With the active ply selected go to the layers treeview. Right click Contours and select Properties.
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Figure 35: Editing the properties of a contours layer.

The following window will appear.
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Figure 36: Properties of the contours layers.

From the Entity drop down menu select the stress you wish to analyse. Next to the Transform field,
click Set.... In the results transformation window select the Material radio button and click OK. This
transforms the stress or strain to the material directions of the active ply i.e the fibre directions of the
active ply.

Figure 37: Results transformation window

When the transformation has been set to follow the material direction the components of the stress
will follow the directions of the fibres. Selecting Sx in the Component drop down menu (Figure 38)
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will plot the stress in the fibre direction of the active ply. Likewise Sy will plot the stress transverse
to the fibres. Sxy will plot the contours of the shear stress in the fibres and so on.

Figure 38: Components of laminate stress

When the desired Entity and Component has been selected press OK. The contours of the stress (or
strain) will be plotted on top of the geometry as shown in Figure 39.

Figure 39: Stress in the fibre direction plotted on a mast

In the red box to the left in Figure 39 the location and magnitude of the maximum and minimum
stress value can be seen. To find the location of the node go to Edit in the top bar and click advanced
selection.
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Figure 40: Advanced selection

The following window will appear:
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Figure 41: Advanced selection dialog window

From the Type and Name drop down menu select Node and enter the numbers of the nodes found
inside the red box in Figure 39. In this case 30307 and 30295. Click OK and the nodes will appear
selected in the model.

The procedure is then repeated for each and every ply in the model. Go back to treeview and select
the next ply and repeat the process until all ply have been examined.

LUSAS has confirmed that there is no function inside the program at the moment for finding the
maximum or minimum stress or strain in a model. The method proposed in this document was the
simplest way found by the authors. It is possible that in future release that such a function might be
included
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4 Determining bending stiffness EI

With the model technique explained in Sections 2 and 3 the bending stiffness EIx and EIy can be
determined for any given mast. The process of determining the bending stiffness includes creating a
LUSAS FE-model according to the loadcase specified in Figure 42.

Figure 42: Loadcase used to determine bending stiffness.

The loadcase is that of a simply supported beam, subjected to an evenly distributed load along its
entire length. The loadcase represents a mast being deflected by its inherent mass alone. To create
the load case in LUSAS the mast section is simply swept to desired length L.

Figure 43: The loadcase modelled in LUSAS.

The length L should be such that the mast can be considered long and slender. For example, a mast
produced on the 535-269 mandrel the length was set to L = 13000 mm. This length ensured, in that
specific case, that the mast was long enough to be considered slender.

If one wishes to determine EIx the supports should be assigned to the points defining the aft line, as
shown in Figure 44
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Figure 44: Support definition when determining EIx.

To define EIy the mast needs to be rotated 90◦. To do this select the entire model by pressing Ctrl+A
then go to Geometry > Surface > Move in the window that appears click the Rotate radio button. In
the Angle field enter 90 and select Z-axis radio button, as shown in Figure 45

39



Bending stiffness modelling of composite mast sections in LUSAS

Figure 45: Geometry rotation dialog window.

The supports can then be assigned to the points defining the B-lines, as shown in Figure 46

Figure 46: Support definition when determining EIy.

Note! that when rotating the model the reference axis for gravity may need to be changed. See
Section 2.5.2

Make sure that a inspection location is assigned at the mid span of the mast, Section 2.7.2. The
deflection w, at the inspection location will later be used to determine the bending stiffness.
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Run the simulation, make sure that the analysis completes without errors and that the model passes
the checklist found in Appendix A.

In Figure 47 the deflection in the loading direction has been plotted

Figure 47: Deflection of the mast in the loading direction.

If the deflection seems reasonable the deflection at the midpoint i.e the deflection at the inspection
location is noted. With this value the bending stiffness can now be determined.

The deflection in the elementary case shown in Figure 42 is determined by:

w(x) = QL3

24EI

(
x4

L4 − 2 x3

L3 + x

L

)
(1)

Where Q is the resultant of the distributed load. In this case Q is calculated as:

Q = qL = mg

L
L = mg (2)

m is the mass of the model. To find the mass of the model see Section 3.2. By setting x = L
2 the

deflection of the midpoint can be determined as:

wmid = 5QL3

384EI
(3)

With this expression the bending stiffness is determined as

EI = 5QL3

384wmid
(4)

Where wmid is taken directly from the LUSAS model. Depending on if the model was modelled
according to Figure 44 or 46 the bending stiffness will be either EIx or EIy.
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A Analysis setup self-check

The following pages contain a basic checklist in order to find possible errors in the analysis setup.
Checking the points in the list will make sure that all most of the possible mistakes when setting up
the analysis can be avoided. It is recommended to read through the list before running the analysis.

42



Checklist for LUSAS simulations 
Points on the list are signed with date and signature once they are checked. 
Points which are not relevant may be crossed but should still be signed. 
Analyst Name:  

Reviewer Name 

Report Number: 

 Comment Date Sign 
Analyst 

Sign 
Reviewer 

     
Geometry     
Is the geometry based on the correct / latest revision?      
Geometry is based on drawings?     
All relevant geometry is included.     
Dimensions agree with drawings.     
     
Mesh     
Correct choice of dimensionality (solids, shells, beams).     
Correct choice of element type (reduced integration, 
hourglass control etc.) 

    

Elements have sufficient quality where it matters?      
Elements have sufficient size where it matters?     
How many percent of elements with warned quality 
exists? 

    

Do coincident elements or nodes exist?     
Element connectivity is correct.     
     
Properties     
Materials are defined according to specification. If no 
reference exists, the material definitions seem 
reasonable. 

    

Sectional properties are correct.     
All regions have been assigned with correct section 
properties. 

    

Shell normal directions are correct.     
All shell/membrane elements are defined on 
midsurfaces? If not, are the offsets correct? 

    

Shell thicknesses are correct.     
Inertia and mass elements are correct.     
Total mass in the .out file corresponds to the report or 
expected value. 

    

Analytical surfaces are correct.     
Material orientations are correct.     
Units are correct and corresponding.     

     
Interactions     
Contact – Master and slave surfaces are correctly 
chosen. 

    

Contact – Initial adjustments of slave nodes are small 
compared to the geometry dimension. 

    

     



 Comment Date Sign 
Analyst 

Sign 
Reviewer 

     
Contact – Appropriate normal and tangential behaviour 
are used (pressure – over closure behaviour, friction 
etc). 

    

Connector elements have the correct functionality (type, 
behaviour, orientation). 

    

Multipoint constraints (MPC, Couplings) are correct.     
     
Boundary Conditions and Loads     
Loads are applied as intended (according to 
specification). 

    

Boundary conditions are applied as intended (according 
to specification) and seem reasonable. 

    

Load amplitudes (time histories) are defined as 
intended (according to specification). 

    

All relevant load cases are evaluated.     
     
Analysis - General     
Sufficient geometry is included for a local analysis.     
Warnings in the .dat file are not critical.     
Local coordinate systems and orientations are correct.     
Is large deformation theory used?      
Have self-weight been included or not?     
Are the FE-model and analysis in general adequate for 
this structural assessment? 

    

     
Analysis – Dynamic specific     
Centre of gravity is correct for all parts.     
Damping is defined according to specification. If no 
reference exists, the assumptions seem reasonable. 

    

Sufficiently small increments are used in the time and 
frequency domain. 

    

     
Results     
Stress levels seem reasonable.     
Magnitude of displacements / deformations seems 
reasonable. 

    

Deformed state seems reasonable.     
Reaction forces are correct.     
The results are extracted properly, from relevant nodes, 
elements, section points. 
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